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Warranty

All products manufactured by ICP DAS are under warranty regarding
defective materials for a period of one year, beginning from the date of

delivery to the original purchaser.

Warning

ICP DAS assumes no liability for any damage resulting from the use of this
product. ICP DAS reserves the right to change this manual at any time
without notice. The information furnished by ICP DAS is believed to be
accurate and reliable. However, no responsibility is assumed by ICP DAS for
its use, not for any infringements of patents or other rights of third parties
resulting from its use.

Copyright

Copyright @ 2020 by ICP DAS Co., Ltd. All rights are reserved.

Trademark

The names used for identification only may be registered trademarks of
their respective companies.

Contact US
If you have any problem, please feel free to contact us.

You can count on us for quick response.

Email: service@icpdas.com
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1. Introduction

This chapter provides an overview of the WP-9000-CE7 and its components, and introduces the

fundamental concepts for user familiar with the WP-9000-CE7.

WP-9000-CE7 Series

The New Generation PAC

pndoss EGAT O

Compact 7

The WP-9000-CE7 is the new generation Windows CE 7.0 based PAC (Programmable Automation
Controller) of ICP DAS. Each WP-9000-CE7 is equipped with a Cortex-A8 (1.0 GHz) CPU running a
Windows CE 7.0 operating system, a variant of input/output ports (VGA, USB, Ethernet,
RS-232/485), and 2/4/8 expansion I/O slots that can be used to integrate high performance 1-9K
(parallel-type) and 1-97K (serial-type) series I/O modules.

Its operating system, Windows CE 7.0, has many advantages, including hard real-time capability,
small core size, fast boot speed, interrupt handling at a deeper level, achievable deterministic
control and low cost. Using Windows CE 7.0 in the WP-9000-CE7 gives it the ability to run PC-based
Control software such as Visual Basic.NET, Visual C#, Visual C++, SCADA software, Soft PLC and etc.
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1.1. Features

The WP-9000-CE7 offers the most comprehensive configuration to meet specific application

requirements. The following list shows the hardware and software features designed to simplify

installation, configuration and application.

Hardware Features

Powerful CPU module
Cortex-A8 1.0 GHz CPU

Memory Size:
- SDRAM (512 MB)
- Flash (256 MB)
- SD card (support up to 32 GB)

VGA Port x 1, USB 2.0 port x 2, Series port (RS-232/RS-485) x 4
64-bit Hardware Serial Number

Dual Watchdog Timers

Dual Ethernet Ports (10 M/100 M/1000 M)

Redundant Power Input

Operating Temperature: -25 ~ +75 °C

Software Features

Windows Embedded Compact 7.0
JavaScript and VBScript

SQL Compact Edition 3.5

.NET Compact Framework 3.5
Remote Display

Rich Software Solution — SDK for Microsoft Visual Studio 2008
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1.2. Specifications

The table below summarizes the specifications of the WP-9000-CE7.

Models WP-9221-CE7 WP-9421-CE7 WP-9821-CE7

System Software

oS Windows CE 7.0

.Net Compact Framework 3.5

FTP Server, Web Server (Supports VB script, JAVA script),
Embedded SQL Server

SDK Provided DIl for VC, DIl for Visual Studio.Net 2008

Embedded Service

English, German, French, Spanish, Russian, Italian, Korean,
Multilanguage Support o ) o )
Simplified Chinese, Traditional Chinese

CPU Module

CPU Cortex-A8 (1.0 GHz)

SDRAM 512 MB (DDR3)

Flash 256 MB

MRAM 128 KB

EEPROM 16 KB

SD SD slot with one SD card

RTC (Real Time Clock) Provide second, minute, hour, date, day of week, month, year

64-bit Hardware Serial )
Yes, for software copy protection

Number

Dual Watchdog Timers Yes (0.8 second)
Programmable LED Indicator 2 (L1,L2)
Rotary Switch Yes (0~ 9)

VGA & Communication Ports

VGA Resolution 800 x 600, 1024 x 768

Dual Ethernet Ports RJ-45, 10 M/100 M/1000 M Base-TX

usB USB 2.0x2

S Internal communication with the high profile I1-97K series

modules in slots

COM 1 RS-232/485 (RxD, TxD and GND for RS-232; Data+, Data- for
RS-485); 3000 Vp¢ isolated
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Models

WP-9221-CE7 WP-9421-CE7 WP-9821-CE7

1/0 Expansion Slots

Number of 1/0 slots

COM 2 RS-485 (Data+, Data-); 3000 Vp isolated

COM 3 RS-232/485 (RxD, TxD and GND for RS-232; Data+, Data- for
RS-485); 3000 Vp¢ isolated

R4 RS-232 (RxD, TxD, CTS, RTS, DSR, DTR, CD, Rl and GND); 3000 Vpc

isolated

Supported types of I/O

modules

Dimensions (W x H x D)

[-9K and I-97K series I/0 Modules

239x 133 x 164 300x 133 x 164 422 x 133 x 164

Installation

Operating Temperature

Wall and DIN-rail mounting

Environmental

-25°C~+75°C

Storage Temperature

-30°C~+80°C

Ambient Relative Humidity

10 % ~ 90 % RH (non-condensing)

Input Range +10 Vpc ™ +30 Vpc

Redundant Power Inputs Yes

Isolation 1kV

Capacity 1.5 A, 5V supply to CPU and backplane; 6.5 A, 5V supply to I/0

expansion slots, total 40 W

Consumption

10.8 W (0.45 A @ 24 V)
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1.3. Overview

The WP-9000-CE7 Series modules are equipped with several interfaces and peripherals that can be

integrated with external systems. Here is an overview of the components and its descriptions.

WP-9221-CE7
Programmable LED Indicator x 2 Operating Modes Selector
System LED Indicator LAN Port x 2 (LAN1 & LAN2)
PWR2 LED Indicator LAN1 LED Indicator

COM3 (RS-232/R5-485)
PWR1 LED Indicator

COM1 (RS-232/RS-485)
SD slot

COM2 (RS-485)
Relay Output
Redundant Power
(PWR1 & PWR2)
COM4 (RS-232)
USB 2.0 x 2 (P1 & P2) I/O Slot x 2
Frame Ground Point VGA Port
WP-9421-CE7
Programmable LED Indicator x 2 Operating Modes Selector
System LED Indicator LAN Port x 2 (LAN1 & LAN2)

PWR2 LED Indicator LAN1 LED Indicator
COM3 (RS-232/RS-485) _—_—
PWR1 LED Indicator vy . :
COM1 (RS-232/RS-485)
SD slot
COM2 (RS-485)
Relay Output

Redundant Power
(PWR1 & PWR2) - i

COM4 (RS-232)
USB 2.0 x 2 (P1 & P2) I/0 Slot x 4
Frame Ground Point VGA Port
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WP-9821-CE7

Programmable LED Indicator x 2 Operating Modes Selector
System LED Indicator LAN Port x 2 (LAN1 & LAN2)

PWR2 LED Indicator LAN1 LED Indicator
COM3 (RS-232/R5-485) ——

PWR1 LED Indicator vy . :
COM1 (RS-232/RS-485)
SD slot
COM2 (RS-485)
Relay Output

Redundant Power
(PWR1 & PWR2)

COM4 (RS-232)
USB 2.0 x 2 (P1 & P2) 1/0 Slot x 8
Frame Ground Point VGA Port

The details of these items are as follows:

Redundant Power (PWR1 and PWR2)

The WP-9000-CE7 has a terminal with 8-wire; there
are 4-wire for redundant power inputs, the details of

the redundant power are shown to the side.

Power Input 2 ——(B2e®

- PGND
- PWR2
WP P.GND

Operating mode Selector

Rotary Switch is an operating mode selector. The WP-9000-CE7 has several operating
modes, for more detailed information about these operating mode, please refer to “2.4
Configuring the Boot Mode”
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LED Indicators

Programmable LED Indicators (L1 and L2)

System LED Indicator

Y a"“‘-\_r\,\r(‘\,.

PWR1 LED Indicator
PWR2 LED Indicator
LAN1 LED Indicator

LAN2 LED Indicators
(Link/Act and 1G)

o

LED Indicator Label State (Color) Meaning
Programmable LED Indicators | L1 and L2 - Programmable LED indicators
System LED indicator RUN Orange OS is running
PWR1 LED Indicator PWR Green Power 1 is on
PWR2 LED Indicator PWR Green Power 2 is on
Green The Link is active
LAN1 LED indicator Link/Act
Blinking Network activity
Green The Link is active
Link/Act
LAN2 LED indicator Blinking Network activity
1G Orange The network speed is 1 G
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Communication Ports

LAN Ports (LAN1 and LAN2)
SD slot
COM1 (RS-232/RS-485)
COM3 (RS-232/RS-485)
COM2 (RS-485)
Relay Output
COM4 (RS-232/RS-485)
USB Ports (P1 and P2)

|
VGAPort  COMO (1/O Slots)

fw\,‘w

e LAN Ports (LAN1 and LAN2)

The WP-9000-CE7 has two Ethernet ports that can be used to connect the router to the Internet

or to other devices.

e SD slot

The SD slot can be used to restore the WP-9000-CE7 system and expand the memory up to 32
GB.

e USB Ports (P1 and P2)

The WP-9000-CE7 has two USB 2.0 ports that can be used to connect the USB devices such as

-~
Y

mouse, keyboard or an external USB hard drive.

Relay Output
e Relay Output
Power Supply 1

The WP-9000-CE7 has a relay output that can be
used to control a light, siren, or other low voltage -@
device when an alarm occurs.

Power Supply 2
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e VGA Port

The WP-9000-CE7 has a VGA port that can be used with a variety of supported VGA resolutions,
and the output resolution covers, 800 x 600, 1024 x768.

e COMO, Expansion 1/0 Slot

The WP-9000-CE7 has 2/4/8 1/0 slots that can be used to
integrate high performance parallel 1/O modules (high
profile I-9K Series) or serial I/0O modules (high profile 1-97K

series).

e COM1 (RS-232/RS-485)

The COM1 port is a 9-pins RS-232/RS-485 connector. The details of the COM1 port specifications
are shown to the side.

Note: 16C550 compatible
Port Type: Male GND+(5) @ Data-
Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps TxD -
: RxD12 @
Data Bits: 5,6, 7, 8 X ®
Data+41)
Parity: None, Even, Odd, Mark (Always 1), Space (Always 0)

Stop Bits: 1, 2
FIFO: 64 bytes

e COM2 (2-wire RS-485)

Note: 16C550 compatible

Port Type: Terminals

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 k
Data Bits: 5,6, 7, 8

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0)

Stop Bits: 1, 2

FIFO: 128 bytes
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e COM3 (RS-232/RS-485)

The COMS3 port is a 9-pins RS-232/RS-485 connector. The details of the COM3 port specifications
are shown to the side.

Note: 16C550 compatible
Port Type: Male GNDHH®) )l oata
Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps @ (®-1+RTS
RxDIHS @H+CTS
Data Bits: 5, 6, 7, 8 TxD1H2 ®
Data+-+H1)
Parity: None, Even, Odd, Mark (Always 1), Space (Always 0)

©

Stop Bits: 1, 2
FIFO: 128 bytes

e COM4 (RS-232)

The COM4 port is a 9-pins RS-232 connector. The details of the COM4 port specifications are
shown to the side.

Note: 16C550 compatible

Port Type: Male %I\%g: g (ORI
Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps ;Xg- g g jﬁIg
Data Bits: 5,6, 7,8 bCD LD ©JfPsR
Parity: None, Even, Odd, Mark (Always 1), Space (Always 0)

Stop Bits: 1, 2
FIFO: 128 bytes

Tips & Warnings

The table below shows the data bit and their corresponding stop bit for
COM1, COM2, COM3 and COM4.

Word Length Number of Stop Bits

5,6,7,8 1
5 1.5
6,7,8 2
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Frame Ground Point

The frame ground point is a small piece of
metal that can be used to terminate the
shield.
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1.4. Dimensions

The diagrams below provide the dimensions of the WP-9000-CE7 to use in defining your enclosure
specifications. Remember to leave room for potential expansion if you are using other components

in your system.

The height dimension is the same for all WP-9000-CE7. The width depending on your choose of I/0

expansion slots. All dimensions are in millimeters.

WP-9221-CE7
164.0
1445
©.a © IEH OamC @ @
875 .
il 133.0 r4 ]
75.5 ©
© © 57.1
L{* |
0|’ © © ||© 0 0 (¥ O ||
3.0
WP-9421-CE7
164.0
144.5 |
of.e © o|le[[[m #75 © T @] &
i] 133.0) r ]
75.5 e
° ° 57.1
L | .
| @’ @ e O e O 0 j
3.0
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WP-9821-CE7

422.0
164.0 404.9
144.5 | 393.1
1 el.e © © ||o] @7.5 + 0 + + + + & + + + 0 0 N
133.0* N
75.5(
© © 57.1]
1
©'d ® @ | O 0 + O ® & & 0 )
3.0
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1.5. Companion CD

This package comes with a CD that provides a collection of the software utility, documentation,
drivers, demo program and application. The CD contains several subdirectories located in
\wp-9000 directory. All of them are listed below.

CD:\wp-9000\

The files package for each release.
!The demo programs for examples of use in the application.

The technical support documents for installation, operation,

maintenance, development and application.

[

The recovered files stored on the micro SD card, that can be used to
boot and recover the system from micro SD card.

0OS_image

|

The files and related information for OS releases and technology.

|

The tools and utilies for operation with PC.

I

The sources for development and application in your application.

[

The tools and drivers related to System_Disk that install on WP-9000.

Update

|

The installation packages related to WP-9000.
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2. Getting Started

This chapter provides a guided tour of the WP-9000-CE7 installation and configuration that

describes the steps needed to download, install, configure, and run the basic procedures for user

working with the WP-9000-CE7 for the first time.

Before starting any task, please check the package contents. If any of the following package

contents are missing or damaged, contact your dealer, distributor.

WP-9221-CE7/WP-9421-CE7/WP-9821-CE7

RJ-45 Waterproof Assembly 44 mm DIN-Rail Clip * 2

A microSD card and a micro Software Utility CD

SD/SD adapter

WP-9000-CE7 Series User Manual, version 1.0.2

Quick Start Guide

M3x6L Screw * 8

Screw Driver
(1C016) 2.4 mm
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2.1. Mounting the WP-9000-CE7

The WP-9000-CE7 can be mounted either directly to a wall/panel, or onto a stainless 35mm DIN
rail.

Wall/Panel mounting

Step 1: Install the four mounting N
screws into the 4 keyhole
mounting holes

lﬁ)@ @o@ll

Step 2: Fasten the screws securely @

Tips & Warnings

A There must be a minimum clearance of 50mm between the WP-9000-CE7
and the top and bottom side of the enclosure panel.

>50 mm
"
l S @
alelea’elele ale
>50 mm
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&
&
&

Step 3: Connect the ground lead
to the frame ground
point

Tips & Warnings

A good common ground reference (earth ground) is essential for proper

A operation of the WP-9000-CE7. One side of all control circuits, power
circuits and the ground lead must be properly connected to earth ground by
either installing a ground rod in close proximity to the enclosure or by
connecting to the incoming power system ground. There must be a
single-point ground (i.e. copper bus bar) for all devices in the enclosure that
require an earth ground.

DIN Rail mounting

Step 1: Fasten the DIN rail clip to the WP-9000-CE7
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Step 2: Clip the device onto a stainless DIN rail

4
i 35 mm

1

A stainless steel DIN rail is recommended.

Tips & Warnings

For DIN rail mounting, it is strongly recommended that only a stainless steel
A DIN rail be used to support the weight of WP-9000-CE7 system, providing
stability and preventing WP-9000-CE7 from leaning
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Step 3: Connect the ground lead to the frame ground point

Tips & Warnings

A good common ground reference (earth ground) is essential for proper

A operation of the WP-9000-CE7. One side of all control circuits, power
circuits and the ground lead must be properly connected to earth ground by
either installing a ground rod in close proximity to the enclosure or by
connecting to the incoming power system ground. There must be a
single-point ground (i.e. copper bus bar) for all devices in the enclosure that
require an earth ground.
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2.2. Installing the RJ-45 waterproof connector assembly

The WP-9000-CE7 is equipped with an RJ-45 waterproof connector to withstand contaminant in

dusty environment.

Step 1: Remove the RJ-45 connector from the RJ-45 cable

i
1
|

Step 2: Feed the end of the RJ-45 cable through the (A) sealing nut, (B) rubber sealing
insert, (C) clamping ring, (D) panel gasket and (E) cable gland base

-8
7T ®

B
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Step 4: Insert the (D) panel gasket into the (C) clamping ring

Step 5: Seat the (C) clamping ring and (D) panel gasket in the (E) cable gland base

Step 6: Push the (E) sealing nut forward and Hand-tighten it to seal the assembly
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Step 7: Insert the RJ-45 cable into the RJ-45 connector

Step 8: Push the RJ-45 waterproof connector assembly forward
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2.3. Deploying a Basic WP-9000-CE7 System

The WP-9000-CE7 provides a variety of communication interface to suit a range of application.

Here is a simple application for using the WP-9000-CE7.

Step 1: Connect the positive terminal (+) of the power supply to the terminal PWR1/2
and the negative terminal (-) of the power supply to the P.GND

Tips & Warnings

2 1. The input range of power supply is +10 to +30 Vpc.

2. The WP-9000-CE7 have two power inputs that can be connected
simultaneously to the two independent power sources. If one power
source fails, the other source takes over automatically. Redundant power
inputs help assure non-stop operation of the WP-9000-CE7.

Power Supply 1
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Step 2: Connect the USB mouse or the USB keyboard to the USB port
Step 3: Connect the monitor to the VGA port

Step 4: Connect to PC or the laptop to the LAN port via an Ethernet switch
VS+ GND ..
Ethernet Switch
+24 Vpc Power Suppl
PPV L N Monitor
+10 to +30 Vbc T

USB Keyboard PC or Laptop
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2.4. Inserting the 1/0 Modules

WP-9000-CE7 has 2/4/8 1/0O expansion slots and only supports |-9K and I-97K series /O modules.

Before choosing the right I/O modules, you first need to know the I/O expansion capacities in
order to choose the best expansion module for achieving maximal efficiency. For more information
about the I/0O expansion modules that are compatible with the WP-9000-CE7, please refer to:
http://www.icpdas.com/root/product/solutions/remote io/i-9k i-97k/i-9k i-97k selection.html

Step 1: Insert the 1/O module

Cord End
Teminal

Step 2: Wiring connection

The metal part of the cord end terminal on the wire can be
direct wired to the terminal of XP-9000-CE7.

s

1. Use screwdriver to push 2. Remove the wiring from

the black clip in. the terminal block

/

Keep on pushing

Remove the wire

-
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2.5. Configuring the Boot Mode

The WP-9000-CE7 has several operating modes, which can be selected by a rotary switch.

The table below lists the operation modes available with the WP-9000-CE7.

Position Operating Mode

0 Normal mode (Default)

Safe mode

Debug mode

OS update mode by Ethernet

OS update mode by SD

1
2
3
4 Reserve
5
6

Reserve (OS Development Mode)

7~9 User Mode

The following is a brief introduction of these modes.

Normal Mode (Default mode)

Normal mode is the default mode of operation and the one you will use most of the
time. Use this mode for more tasks and configurations. Programs also are executed in
this mode.

Safe Mode

Safe mode is a troubleshooting mode. The mode loads the minimum required device
drivers and system services to boot the WP-9000-CE7.

If you have malicious software or a program caused the WP-9000-CE7 cannot be boot

or run the normal mode, you can boot in safe mode to solve the problem.
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Debug Mode

Debug mode is a special environment in which program debug functions can be used
in addition to normal system functions.

Debug mode is unsupported.

OS Update Mode

OS update mode is a way used to update OS. For more information on updating the
WP-9000-CE7 OS image, please refer to section 7.1. OS updates

Reserve — OS Development Mode

The positions 4, 6, of rotary switch are reserved for OS development.

User Mode

The positions 7, 8, 9 of rotary switch are reserved for user’s applications.

When WP-9000-CE7 is boot with one of these positions, it is boot at normal mode.

User’s application can check the position of the rotary switch position to run at
different mode.
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2.6. Changing the User Interface Language

The Regional and Language Settings is a Windows CE functionality that allows users to change the

WP-9000-CE7 user interface with your native language.

Step 1: Click Start menu, point to Settings, click Control Panel, and then click Regional
Settings

l@ Prograrns ’
'-ﬂ? Fawvorites

D Documents
B Settings

-

B Contral Panel
(}, Metwork and Dial-up Connections
a Taskbar and Start Men...

Settings

Regional and Language Settings

Regional Settings Lser Intetface Language I Input Language |

-Your locale

The locale option affects how some programs format numbers, currency,
time and dates,

Customize...
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Step 2: Click User Interface Language tab, choose to your local language, and then click
OK button

Regional and Language Settings m

| Regional Settings | User Interface Language | Input Language |
-User Interface Language

The option will determine the language used for the menus, dialogs
and alerts,

English (United States El
English (United States) :
French (France)

German (Germnarny)

Ttalian (Ttaly)

Portuguese (Brazil

Spanish (Spain - International Sort)

Step 3: Double-click the PAC Utility on the desktop, and then reboot the WP-9000-CE7
for changes to take effect

lf/ - ﬂ
Double-click

the PAC Ultility J PAC Utility [1.2.1.4]

iiE Help

j";l-
Save ﬁ
Save and Reboot e | ERAES 7

Reboot

'

i

o
Restare Utility Default Settings A
Exit {
PAC UtP

a3
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2.7. Using PAC Utility to Manage the WP-9000-CE7

The PAC Utility is a collection of the WP-9000-CE7 system tool that allows users to manage and
configure the WP-9000-CE7 quickly and easily.

For more detailed information on PAC Utility applications, please refer to “3.1. PAC Utility”

Step 1: Double-click the PAC Utility on the desktop

Step 2: Configure IP address (DHCP), FTP Server, Auto Execution files..., etc.

> ||
% 7 E_ile Help
. ] General | General2 ID\sp\ay IIP Config | Network |Dewce Infarmation I AUtn Execution IRntary E}{d l I >
A -

ACcess Login

Double-click
the PAC Utlllty FTP @ Enable () Disable

Allow Anonymous @ Enable (O Disable

Set FTP default download directory to:

[ Lo | ot |
Iy Device

- Network
Set HTTP dof - Systemn_disk
windowstw] --Recycled Apply

- Application Data

i+ My Recent Documents
i+ My Documents

I——————————————o ProgramFiles |
e Windowes
Cancel | Ok
Step 3: Reboot the WP-9000-CE7 for changes to take effect
PAC Utility [1.2.1.4]

iﬁﬁ Help 7

Save ﬁ’

Save and Reboot prifig | Network 3

Reboot {'I
— L
s

Restore Litility Default Settings £

Exit {

AC Uty

™
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2.8. Using DCON Utility Pro Configure I/0 Modules

DCON Utility Pro allows users to configure and manage the I/0O modules via Ethernet or serial ports

(RS-232/RS-485).

Step 1: Double-click the DCON_Utility_Pro on the desktop

.8

Double-click the
DCON_Utility Pro

J

Step 2: Click the % button

[C O Pro 0.0 »
— | .I
33 0E &R

Start Address [0 | End Address

D IAddr... |Baud Rate IChecka... |Format|5ta1u5 |Descriptiom
1] | [#

[ |
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Step 3: Configure the communication settings

COM Port Option

COM Port Timeout
[coMO[Backplane] 300 ms
COM T ecksum Format
iZCM2 Q |
CCM3
COM4 b2 [E=1 [Noel
K Cancel
Tips & Warnings

A The COM port settings for expansion I/O modules are listed below.

COMO [Backplane] <&

\4
com1/2/3/4

For more information on these COM port selections, please refer to the

specification of the pin assignments in section 1.3. Overview
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Step 4: Click the b‘ button to scan the I/O module

Step 5: Click the module name to configure the 1/0 module

DCON UtilitxBeo CE ¥ 2.0.0.5

oo <]

Start Address El Erd Address

Addr...J Baud Rate |Check5... IFormatI Stahus IDescription
97015 ;TO Disable  N8,1 [DCONIS*AI (Universal RTU
97015 Virmware[B200]
Configuration |.£\I |Abc.ut|
ProfocolNIT*)  [ooon =l
Address 0 E [00H]
Baud Rate(NIT*)  |115200 =
Parity (INIT*) {1,2, 1-Mone Parity 5]
Checksum(INIT*)  |Diszble =
1] Analog Format Ohms [~
[ 60750 Hz E =]
COM:O[N,8,1] |f Save Configurations to the File
Write Configurations to 10 Module

Response Delay 0 ms ‘ J 4

Exit |
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3. Tools and Tasks

This chapter provides a brief introduction of the WP-9000-CE7 service tools and its benefits.

There are several tools and utilities built-in and designed for use with WP-9000-CE7. Some of these
are pre-installed on WP-9000-CE7 and can work directly on WP-9000-CE7, and some of these are
supporting tools and can help you to manage the WP-9000-CE7 remotely on a PC.

The following tools are pre-installed on WP-9000-CE7 and can work directly on WP-9000-CE7 that
can be found on the CD that was provided with the package or by downloading the latest version
from ICP DAS web site.

CD:\wp-9000\System_Disk\Tools\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/system_disk/tools/

B ocon vy rro
N o mstr ool
T
T
T
B cemoic oipi
N senimocon
T
e
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3.1. PAC Utility

PAC Utility is a collection of software applications that enable management and configuration of
WP-9000-CE7 system and features.

PAC Utility [1.2.1.4] ! E

- General | Generalz I Dizplay IIF' Canfig INetwcurk IDevice Infor matian Ihub:u Execution IRDtary Exg 1] ¥

Welcorme to use PAC Uitility
This tool will help you easy o
Lse PAC CE series.

PAC Utility

Task Bar setting:
[ &wuto Hide

[ alhways On Tap

HIVE Registry:
@ Auto Save Ta Flash (Default)

() Maunal Save To Flash

Backplane Battery [7] Enable &utorun in plugging LSE Disk
Batteryl : Ok Battery2 : Ok [[] Enable &utorun in plugging Micra S0

RTC Battery

Canfigure the synchronization with a time server | Configure | | Backlight Setting

The PAC Utility includes the following menu bars and property tabs.
All of these functions will be explained later.

Menu bar Property Tab

File General

Help General2
Display
IP Config
Network

Device Information
Auto Execution

Rotary Execution

WP-9000-CE7 Series User Manual, version 1.0.2 Page: 40

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved. DX E-mail: service@icpdas.com



3.1.1. Menu Bar -File

iﬁﬁ Help

Save
Save and Reboot
Reboot

Restare Utility Default Settings
Exit

The menus use to How to use

Reboot Restarts the WP-9000-CE7

Restore Utility Default Settings Restore the WP-9000-CE7 to default settings.

Exit Exits the PAC Utility.
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3.1.2. Menu Bar - Help

Ahout PAC Utility

PAC Utility
Yersion: 1.2.0.5

Copy Right () 2005, ICPDAS Co., LTD.
All Rights Reserved, PAC Utility and the
PAC Utility logos are rademarks of
ICPDAS,

P&C Windows CE; en-US)

The menus use to How to use

About Displays a dialog box with information about PAC Utility,
including the current version and copyright information.
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3.1.3. Property Tab - General

The General tab provides functions to configure the task bar, check the status of the battery..., etc.

PAC Utility [1.2.1.4]

File Help

Welcome o use PAC Utility
This 1oal will help you easy to
Lse PAC CE series,

Taszk Bar setting:

[ suto Hide

[ sbways On Top
HIYE Reqgistry:

® suto Save To Flash (Defaulty
S (") Maunal Save To Flash

Backplane Battery [7] Enable sutarun in plugging USE Disk
Batteryl : Ok Batteryz @ Ok [] Enable sutarun in plugging Micro SO

RTC Battery

Canfigure the synchronization with a time server | Configure | | Backlight Setting

The tab use to l How to use

Lock or Auto-Hide | Auto-Hide the taskbar:
the taskbar Select the Auto Hide check box.
Lock the taskbar:

Select the Always On Top check box.

Auto save or Auto save to flash:

manual save to Select the Auto Save To Flash (Default) check box.

flash Any changes made to the WP-9000-CE7 will be saved and only take
effect after the WP-9000-CE7 reboots.

Manual save to flash: PAC Utility [1.2.1.4]
Select the Manual Save to Flash JI=Y Help

check box. Save and Reboot

Any changes made to the Reboat

WP-9000-CE7 will be saved by >
Restore Utility Default Setti
clicking the Save and Reboot from E;i o IR HEtEU Setioe
File menu. W
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The tab use to ’ How to use

Enable USB autorun Select the Enable Autorun in plugging USB Disk check box.

Enable SD auotrun This item is temporarily unavailable.

Automatic synchronization | Refer to the Appendix A.2. How to configure the service for
of system time automatically synchronizing with the internet time server.
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3.1.4. Property Tab — General2

The General2 tab provides functions to specify the name of the USB disk.

PAC Utility [1.2.1.4] ! E m
| File Help |

[General ] General2 | Display I IP Config I Network I Device Information l Autn Execution | Rotary Exé 4 I 4

Naming the CF Card and USB Hard Disk

Set
USBE Hard Disk: |USB_DiSk |

The tab use to How to use

Specify the name of the USB disk Enter a name in the USB Hard Disk: field
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3.1.5. Property Tab — Display

The Display tab provides functions to configure the monitor settings.

File Help

I General I General? |

Screen resolution: Screen refresh rate:

Less I M+lare: EI

640 by 480 pixels

The tab use to How to use

) Move the slider to the left to decrease the resolution or move the
Adjust the screen ] ) ) ) )
. slider to the right to increase the resolution, and then click the Apply
resolution
button.

Change the screen Select the desired refresh rate from the Screen refresh rate
refresh rate drop-down list, and then click the Apply button.
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3.1.6. Property Tab - IP Config

The IP Config tab provides functions to configure either DHCP (Roaming) or manually configured
(Static) network settings and to monitor the MAC address. Generally, DHCP is the default settings,
but if you don’t have a DHCP server, you must configure the network settings by using manual
configuration.

PAC Utility [1.2.1.4] ! E

LAM 1: LAN 2:

MaC Address: 00-00-E0-55-66-01 MaC Address: 00-0D-E0-55-66-D2

{3 Use DHCP to get IP address {) Use DHCP to get IP address

) 2ssign IP address @ tssign IP address

IP Address: ‘ | IP Address: | |

Mask: ‘ | Mlask: | |

Gateway ‘ | Gateway | |

OMS Server: ‘ | DMNS Server: | |
[T] Reboot for changes to take effective [T] Reboot for changes to take effective

The tab use to l How to use

Use DHCP to get IP address:
Select the Use DHCP to get IP address option, and then click the Apply
button.

Set the network

settings .
Assign an IP address:
Select the Assign IP address option, and then click the Apply button.
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3.1.7. Property Tab — Network

The Network tab comprises three tabs — Access, Login and File Server Settings.

Access

The Access tab provides functions to enable/disable the FTP access, enable/disable anonymous
FTP access, and configure the FTP and HTTP directory path.

PAC Utility [1.2.1.4] ! E

[General General2 IDispIay IIF' Config | Metwark | Device Information I ALt Execution I Rotary Exe 4| 0

Access | Login | File Server Settings |

FTF (@ Enablz () Disable

Allow Anonymous (@ Enable () Disable

Set FTP default download directory to:

' [

Set HTTF docurment root directory to:

W IS i e LI, H || Apply

The tab use to How to use

Enable the FTP access:
Select the Enable check box in the FTP field, and then click the
Enable or disable the Apply button.

FTP access Disable the FTP access:
Select the Disable check box in the FTP field, and then click the
Apply button.
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The tab use to How to use

Enable anonymous FTP access:
) Select the Enable check box in the Allow Anonymous field, and then
Enable or disable )
click the Apply button.
anonymous FTP .
Disable anonymous FTP access:
access
Select the Disable check box in the Allow Anonymous field, and then
click the Apply button.
Set the FTP Enter a new path in the Set FTP default download directory to: field,
directory path and then click the Apply button.
Set the HTTP Enter a new path in the Set HTTP document root directory to: field,
directory path and then click the Apply button.
Login

The Login tab provides functions to maintain the FTP accounts.

PAC Utility [1.2.1.4] ! E

[General I General2 IDispIay IIF' Config | Metwork | Device Information Iﬁuh:u Execution IRDtary E}{EI 1 I 4

[Access | Login | File Server Settings |

User Natme Password

Jdmin | [+ || add || Deete

Lser name Passwiord

The tab use to How to use
Maintain the FTP Refer to the Appendix C.1 How to add a user account to remote
accounts login the WP-9000-CE7 from PC.
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File Server Settings

The File Server Settings tab provides functions to set the SMB server.

PAC Utility [1.2.0.6] M [=]

IGeneraI I Digplary IIF' Config ‘ Metwork | Device Information Iﬂub:l Execution IRDtarﬁ,r Execution |

ACCEess I Login | File Server Settings |

fou can create a networked file server and enables clients to store and
retrieve files, and makes use of the Internet for communication between
client devices and other shared equipment,

;'_"__J Settings Share Files System Settings !

Device Mame (Each device need setting
a different device name)

Compact

The path 1o the folder to be shared

Configure the file server to use LANY as
the network adapter

|PCrFETCESRZ Bd

Enzble all authentication on the file

server, The file server will not be
accessible o all users on the

[ retwork and the "admin" as the

Lser to be allowed access o the

file server

Set

Help

The tab use to How to use
Set the SMB server Click the Settings button to set the SMB server path.
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3.1.8. Property Tab — Device Information

The Device Information tab provides functions to monitor necessary system information of the

WP-9000-CE7. The information is the most important note of version control for upgrading system.

Gereral \ Generalz ] Display ] IF Config ] Metwork || Device Information l AL Execution I Rotary Exg 4| ¥

Slot 1: I:I Module{CPL) Type: | |
Slat 2; I:I Serial Number [o1-82-4p-06-18-00-00-D |
Slot 3: I:I Backplane Yersion: | |
Slot 4: |:| CPL Yersion: |1,|j,|:|,|:| |
Sots: [ ] 0Swversion: [1.0.1.1, 2015/10/30 09:36:5 |
Slot 6: |:| Eboot Version: [1.2.1.0, 2015/10/22 16:26:0 |
sot7: [ |  METCFversan:  [357338.00 |
SOL CE Yersion: |3,5,3154,|:|

|
PACSOK Yersion: |4,3,3,4 |
|

CPU Temperature: |
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3.1.9. Property Tab — Auto Execution

The Auto Execution tab provides functions to configure programs running at WP-9000-CE7 startup,

it allows users to configure ten execute files at most.

Tips & Warnings

Q The specific extensions are .exe and .bat, and they are executed in order of
program 1, program 2, etc.

PAC Utility [1.2.1.4] ! E

[ General I General2 I Display I IF Config I Metwork IDeuice Information | Auto Execution | Rotary Exg 1| ¥

Program 1: |"-.-"_REMDTE.E}{E | Browse |

! Prograrn 2: | | | Browse |

l:_"uf Program 3: | | | Browse |
Prograrm 4: | | | Browse I

At most 10 programs  Fregram S: | | | Brawse |

can be specified to .

ExeCUtE autormatically Frogram &: | | | Browse |

at system startup. Program 7: | | | Browss I
Program 2: | | | Browse I
Prograrm 9: | | | Browse |
Programl0; | | | Browse I

The tab use to l How to use
Configure programs Click the Browse button to select the execute file which you want,
running at startup and then click the Apply button.
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3.1.10. Property Tab — Rotary Execution

The Rotary Execution tab provides functions to configure programs running at WP-9000-CE7
startup in one of the user defined mode, it allows users to configure ten execute files at most.

PAC Utility [1.2.1.4] ! E

[GeneraIE IDispIay IIF' Config INetwurk IDevice Informatian Iﬂu’o:u Execution | Raotary Execufion I_I\I L

Rotary Switch 0 |Nurmal Mode | | Browse |
Rotary Switch 1: [Safe Mode | _Browse |
Rotary Switch 2. | | . Browse |
Rotary Switch 3: | | _erowse |
Rotary Switch 4. | | | Browse |
Rotary Switch 5: | | _Browse |
Rotary Switch 6. | | . Browse |
Rotary Switch 7: | | _Browse |
Rotary Switch 2: | | . Browse |
Rotary Switch 9: | | _Browse_|

The tab use to How to use

Configure programs running at startup | Click the Browse button to select the execute file

in one of the user defined mode which you want, and then click the Apply button.
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3.2. DCON Utility Pro

DCON Utility Pro enables users easily to configure and manage the I/O modules via Ethernet or
serial ports (RS-232/RS-485).

For more information on how to use DCON Utility Pro to configure I/O modules, please refer to 2.7.
Using DCON Utility Pro to Configure I/O Modules

For more detailed information on DCON Utility application, please refer to:

http://www.icpdas.com/root/product/solutions/software/utilities/dcon utiltiy pro.html

DCON Utility Pro CE V 2.0.0.4

Start Address 0 End Address |4
o Addr... | Baud Rate | Checks... |Format| Status | Description

Terminal Command Line Tool
COMPort  |COMO[Backplane x| Protocol — [oon =
BaudRate  [115200 iFormat  |i,3,1-None Parity [ Send
Checksum  [Disable T gt [sltol=] | =]
Timeout 100 ms SelectlD | 4
Command 400M
Resporse
|
4 I E ata Logger I Aboutl
| COM Port, COM Port |COMD EI Load
ICOMD E Protocal m
Data Format |N,8J1 El Add ==

Checksum IDisabIe :I
Slot I E Modify rh |

Timeaut {ms) Iggg(mg) El Cave

Delay for Next (ms) m

Command Reference | E'
Send Command |$DlM |
Compared Response |Input Compared Data |
Compare Made |Fu|| Match El
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3.3. TaskMgr

The TaskMgr is a Windows CE application, which provides real time info on all processes and

threads including System threads, similar in appearance to the Windows Task Manager.

Windows CE Task Manager

Performance IPmcesses Iﬁpp]j;:aticu 1 n
100

Windows CE Task Manager

TaskIvlanager e
w_remote exe
servicesd.exe
explorer.exe |
Usage 2% CrarelTser exe Task
ndevice exe @
= | udeviceexs VY Virtual CE
NE BEYE
Jl
|
a | B
Cloze Switch
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3.4. VCEP

ICP DAS VCEP is designed for managing your WP-9000-CE7 anywhere. No matter where you are,
ICP DAS VCEP provides a convenient environment on the Desktop PC and lets you control your
WP-9000-CE7 remotely.

=
VirTual CE 5
Connected
Ready

Primary IF = 10.1.0.95
License Free Version

Wideo=G01

Wiy iCpdas, com

ICP DAS VCEP is composed of two main components: The Server which runs on WP-9000-CE7 and
the Client which runs on a Desktop PC.

Once a connection is established between the client and server (initiated by the client), the client

will periodically send requests for screen updates and send mouse/key click information to the
server to simulate.

Each video frame is inter-compressed against the previous frame and then intra-compressed with a
modified LZW scheme to minimize the amount of data transmitted from server to client.

For more detailed information on VCEP application, please refer to
http://ftp.icpdas.com.tw/pub/cd/winpac_am335x/WP-9000-CE7/pc tools/vcep/
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3.5. Remote_Display

The Remote Display allows WP-9000-CE7 to be controlled and monitored from a remote location.

This tool is composed of two parts, a client and a server. The server is a program named
cerdisp.exe running on WP-9000-CE7. The client is a PC-based program named cerhost.exe running
on the PC.

:.
—

cerdisp cerhost

Once a connection is established between the client and server (initiated by the client), the client
will periodically send requests for screen updates and send mouse/key click information to the

server to simulate.
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3.6. SendToCOM

The SendToCOM uses the serial port to communicate with expansion module. To use the
SendToCOM, you can send data to expansion module through the serial port, and receive data
from other device through the serial port.

For more information about these commands for communicating with expansion module, please
refer to:

http://www.icpdas.com/root/product/solutions/remote io/rs-485/i-8k i-87k/i-8k i-87k selection.
html#b

ICPDAS Send to COM V1.0.4 2011f2/23
Connection Status
COM Part Baudrate [rata Bit Parity: Stop Bit Slak
|COM2 ~] |1152|:n:| ~] |8 :I IIZI—Nu:une Parity | w| |1 =] | E2
Endstring with @ mone (YLFcR (YR (O criF OWF [string | 4 +cre
Binar Skrin m Polling
Carmmands Responses O ! @ d - -
Current Packet Size (bytes) g Current Packet Size (bybes) g fuka send Inkernal (ms)  |sop
Total Packet Bytes il Tokal Packet Bykes il | Skark | | Stop | Sek
Packet Quantity send ] Packet Quantity received |0 ckart Time |Start Time
ﬂl Stop Time  |5top Time
FS FS
w w
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3.7. RegEdit

The RegEdit provides a hierarchical representation of the registry on a target computer, similar in
appearance to the Windows Registry Editor. The standard registry roots are represented; you can
add keys beneath a root to point to existing registry keys, or you can add your own keys. Values can
be changed for existing keys, or added for new keys, and default keys can be specified. For more

information, see Registry Settings Management in Deployment.

Registry Editor Version 1.2.2 ! E

File Help

Mame I Type I Data I

-- HKEY_LOCAL _MACHINE
- HKEY_USERS
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3.8. 1SQLW35

The ISQLW35 is a Windows Embedded Compact 7 functionality that implements SQL Server
Compact 3.5 Query.

soL | [ arid Mates

----- {a T atabases

Tools 501 | f A U X
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3.9. INotepad

The INotepad is a common text-only editor. The resulting files have no format tags or styles.

INotepad !
File Edit Format Help

e

Esc|1|2(3|4|5|6]|7 9(0[- (=]
TabjaJwle]r[t]yu]ifo]p]I]]
CAP|a|s |d|[f[g|h|]]k]|I]/
Shift| z[x[c|v|b|nm|.]|. ]/
| ctifai] " Ty ] Lt]e]>
WP-9000-CE7 Series User Manual, version 1.0.2 Page: 61

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved. DX E-mail: service@icpdas.com




4. Your First WP-9000-CE7 Program

This chapter provides a guided tour that describes the steps needed to set-up a development

environment, download, install, configure for user programming with WP-9000-CE7 modules.

4.1. Setting up the Development Environment

Before writing your first program, ensure that you have the necessary development tool and the
corresponding SDKs are installed on your system.
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4.1.1. Preparing the Development Tools and Programming Languages

WP-9000-CE7 is a Windows CE-based device that supports three programming languages for
developing Windows CE applications.

e Visual Basic.NET
e Visual CH

e Visual C++

Development Tools

WP-9000-CE7 supports the application development with the Professional Edition application of
Visual Studio 2008.

Micrg:vsc:rft"c .
%Vlsual Studio 2008

Professional Edition

Tips & Warnings

A There are some updates for Visual Studio 2008 to provide support for
Windows Embedded Compact 7.

If you have Professional Edition of Visual Studio 2008 are installed, make
sure all of the following package are installed

1. Visual Studio 2008 Service Pack 1

http://www.microsoft.com/en-us/download/details.aspx?id=10986

2. Visual Studio 2008 update for Windows Embedded Compact 7

http://www.microsoft.com/en-us/download/confirmation.aspx?id=11935

3. Windows Embedded Compact 7 ATL Update for Visual Studio 2008 SP1

http://support.microsoft.com/kb/2468183/en-us
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4.1.2. Installing the WP-9000-CE7 SDK

The WP-9000-CE7 SDK offers several APIs for customizing the standard features and integrating
with other applications, devices and services.

Step 1: Get the latest version of the WP-9000-CE7 SDK, AM335x_WINCE7_SDKV100B03

The WP-9000-CE7 SDK can be found from the CD that was provided with the package

or by downloading the latest version from ICP DAS web site.

CD:\WP-9000\SDK\PlatformSDK\
http://ftp.icpdas.com/pub/cd/winpac am335x/wp-9000/sdk/platformsdk/

Step 2: Execute the AM335x_WINCE7_SDK_YYYYMMDD.msi

Follow the prompts until the installation process is complete.

Step 3: Execute the VisualStudioDeviceWindowsEmbeddedCompact?7

Follow the prompts until the installation process is complete.
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4.1.3. Setting up the Global Compiler Settings (for Visual C++)

The directories can be specified where the compiler will search for include files and libraries.

Step 1: Start Visual Studio 2008

"2

Step 2: On the Tools menu, click Options...

File Edit View |Tools | Test Window Help
Attach to Process... Ctrl+Alt+P

Device Security Manager...

Connect to Device...

Mw;amr Mragsr’ —— '.' -

Y

Visual Stuu.. 004 Command Prompt
8 | WCF Service Configuration Editor

External Tools...

Import and Export Settings...

Customize...

Options...
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Step 3: In the Options dialog box, expand the Projects folder, and then click the VC++
Directories

Step 4: In the Show directories for: drop-down list, select Include files

Step 5: Use the buttons in the Options dialog box to add additional include paths

The path of “S(VCInstallDir)ce7\include” and “S(VClinstallDir)ce7\atimfc\include”
must be moved to the top of the list.

Options g Pl

Environment Platform: Show directories for:
Projects and Solutions |AM335x_WINCE7_SDK (ARMv4]) v/ [Include files -
General
Build and Run
Ve Defal:llts : $(VCInstallDir)ce\include -
i VC++ Directories $(VCInstallDir)ce7\include
| VC++ Project Settings C\Program Files (x86)\Windows CE Tools\SDKs\AM335x_WINCE7_SDK\include
Source Control Ch\Program Files (x86)\Windows CE Tools\SDKs\AM335x_WINCE7_SDK\include',
I Text Editor $(VCInstallDir)ceM\atimfchinclude
L $(VCInstallDirce\atimfc\include
| | Database Tools $(VSInstallDinSmartDevices\SDK\SQL Server\Mobile\v3.0
Debugging
Device Tools
I HTML Designer
: Office Tools il
I Test Tools <] m | N
Text Templating
[ Windows Forms Designer Include Directories . . . o .
Workflow Desianer Path to use when searching for include files while building a VC++ project. -
| 9 Corresponds to environment variable INCLUDE.
OK I l Cancel
A 4
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4.2. First WP-9000-CE7 Program in VB.NET

The best way to learn programming with WP-9000-CE7 is to actually create a WP-9000-CE7
program.

The example below demonstrates how to create a demo program running on WP-9000-CE7 with
VB.NET.

To create a demo program with VB.NET that includes the following main steps:

1. Create a new project

2. Specify the path of the PAC reference

3. Add the control to the form

4. Add the event handling for the control

5. Upload the application to WP-9000-CE7
6. Execute the application on WP-9000-CE7

All main steps will be described in the following subsection.

In this tutorial, we will assume that you have installed WP-9000-CE7 SDK on PC and used the Visual
Studio 2008 for application development.
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4.2.1. Create a new project

The Visual VB.net project template is a composite control that you use in this example creates a

new project with this user control.

Step 1: Start Visual Studio 2008

"2

Step 2: On the File menu, point to New, and then click Project

Edit View Tools Test Window Help

New » | 5] Project. Ctrl+Shift+N
| Open » | @  WebSite.. Shift+Alt+N

Close ' | File.. Ctrl+N

Close Solution Project From Existing Code...

Save Selected Items  Ctrl+5
Save Selected Items As...
Save All Ctrl+Shift+5

® &t

Export Template..

W] | Page Setup..
3 | Print.. Ctrl+P
Recent Files »
Recent Projects »
Exit
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Step 3: In the Project types pane, expand Visual Basic node and select Smart Device

Step 4: In the list of Templates, select Smart Device Project

Step 5: Specify a name and a location for the application and then click OK

Project types: Templates: I-NI:T Framework 3.5 ~ ]

General + || Visual Studio installed templates

MFC |ESmart Device Project|

Smart Device

Test

Win32

Other Languages

Visual Basic
Windows
Web
Smart Device
Office
Database
Reporting
Test L
WCF
Workflow

Visual C#

A project for Smart Device applications. Choose target platform, Framework version, and template in the next dialog box.

—[| My Templates

.}dSearch Online Templates...

11

-

Name: SDK Info
Lacation: C\Users\Administrator\Documents\Visual Studio 2008\Projects - Browse...
Solution Name: SDK_Info Create directory for solution
I
OK I l Cancel l
|
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Step 6: In the Target platform, select Windows CE

Step 7: In the .NET Compact Framework version, select .NET Compact Framework
Version 3.5.

Tips & Warnings

Windows CE7 only supports .NET Compact Framework Version 3.5, if your
application uses .NET Compact Framework Version 2.0 there is no guarantee
that the program will function correctly.

Step 8: In the list of templates, select Device Application. Click OK

Add New Smart Device Project - SDK Info @g
Target platform: ’Windows CE vl
NET Compact Framework version: ’.NET Compact Framewaork Version 2.5 vl
Templates:

1]
B @ W F P oot
= = e = Description:
Device Class Console Control Empty . ]

Application  Library  Application  Library Project A project for creating a NET
Compact Framework 3.5 forms
application for Windows CE
Platform

Download additonal emulator images and smart device SDKs...

] oK I [ Cancel ||
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4.2.2. Specify the path of the PAC reference

The PAC SDK provides a complete solution to integrate with WP-9000-CE7 and it’s compatible with
Visual C#, Visual Basic.NET and C++. In order to use a component in your application, you must first
add a reference to it.

Stepl: Get the PACNET.dII

)
s+

PACNET.II

The PACNET.dIl can be found from the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.

CD:\WP-9000\SDK\PACNET\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/sdk/pacnet/

Step 2: On the Project menu, and then click Add Reference...

% SDK_Info - Microsoft Visual Studio (Administrator) I » ~-* J 3

File Edit View | Project| Build Debug Data Format Tools Test Window Help
Add Windows Form...
Add User Control...

Add Component...

Add Module...

Add Class..

Add New Item... Ctrl+Shift+A
Add Existing Item...  Shift+Alt+A

E L & BB E

Exclude From Project
Show All Files

Add Reference...

Add Web Reference...
Set as StartUp Project

&

+4 | Refresh Project Toolbox Items

Change Target Platform...
SDK_Info Properties... Alt+F7
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Step 3: On the Browse tab and browse to where the PACNET.dIl are installed, and then
click OK

| .NET | Projects| Browse |Recent
Lookin: | PACNET ~ @7 &~
Mame r Date modified
| @) PACNET.II 2014/5/30
<« | Il 3
File name: : PACNET -
Files oftype: @ |Component Files (*.d11¥ 11b;¥* olb;* ocxs¥. exe) -
OK ‘ ‘ Cancel
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4.2.3. Add the control to the form

You can drag various controls from the Toolbox onto the form. These controls are not really "live";
they are just images that are convenient to move around on the form into a precise location.

After you add a control to your form, you can use the Properties window to set its properties, such
as background color and default text. The values that you specify in the Properties window are the
initial values that will be assigned to that property when the control is created at run time.

Step 1: On the Toolbox panel, drag a Button control onto the form

‘

e
Toolbox + 1 X
All Device Controls -

B Common Device Contr...
k Pointer

&) Button | \‘
CheckBox —\
=5 ComboBox

T DateTimePicker
A Label

A LinkLabel

8 ListBox

:: ListView

F] MonthCalendar
£ NumericUpDown
[ PictureBox

@ ProgressBar

® RadioButton

+|+ Splitter

TextBox

% TrackBar

i TreeView

[T WebBrowser
Device Containers L
Device Menus & Toolb...
Device Data

Device Components
Device Dialogs

B General -~

m

MS.. [T [BC. [ZP. [FR. |
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Step 2: On the Properties panel, type Check the SDK version in the Text field

Properties

Buttonl System.Windows.Forms.Button

o=]4) [B]# |E

=B Appearance o
BackColor |:| Control

Font Tahoma, 10pt !
ForeColor . ControlText =

Check the SDK Version| m___;‘"

= Behavior
ContextMenu (none)
DialogResult None
Enabled True

a Check the SDK Version |
LF )

TabIndex 0
TabStop True -
Text

The text contained in the control.
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4.2.4. Add the event handling for the control

You have finished the design stage of your application and are at the point when you can start

adding some code to provide the program's functionality.

Step 1: Double-click the button on the form

a Check the SDK Version
LF

Step 2: Inserting the following code

Dim data(30) As Byte
PACNET.Sys.GetSDKVersion(data)
MessageBox.Show(PACNET.MISC.WideString(data))

EPohlic Class Forml ;3
{

Private Sub Buttonl Click(BvVal sender As Svstem.0bject, ByVal e @EL
3

Din data(30) As Byte ~

PACHET .5vs.GetsDEVersionidata) {}

| MessageBox . Show(PACKET . MISC . WideString{data)) f}

End Suh
End Class E}

\/wmwwvmumw ""“v"‘"‘\f

Tips & Warnings

A The “PACNET” of “using PACNET” is case- sensitive.
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4.2.5. Upload the application to WP-9000-CE7

WP-9000-CE7 supports FTP server service. You can upload files to WP-9000-CE7 or download files
from a public FTP server.

Step 1: On the Build menu, and then click Build [Project Name]

File Edit View Project |Build | Debug Data Format Tools Test Window Help
Build Solution F7
Rebuild Solution  Ctrl+Alt+F7

Deploy Solution
Clean Solution
% Build SDK Info
Rebuild SDK_Info
Deploy SDK_Info
Clean SDK_Info

Configuration Manager...
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Step 2: Open the browser and type the IP address of WP-9000-CE7

Step 3: Upload the application and the corresponding PACNET.dII files to WP-9000-CE7

Tips & Warnings

A For applications programming in C# and VB.net with .net compact
framework, when executing these application on WP-9000-CE7, the

corresponding PACNET.dIl must be in the same directory as the .exe file.

| File Edit View Go Favorites ||”J|£
”]Agldress | YTemp

= O

PACMET SDK_Info

R/\U/v‘“"\

N N YA
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4.2.6. Execute the application on WP-9000-CE7

After uploading the application to WP-9000-CE7, you can just double-click it on WP-9000-CE7 to

execute it.

S0k _Info
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4.3. First WP-9000-CE7 Program in Visual C#

The best way to learn programming with WP-9000-CE7 is to actually create a WP-9000-CE7
program.

The example below demonstrates how to create a demo program running on WP-9000-CE7 with
Visual CH.

To create a demo program with Visual C# that includes the following main steps:

1. Create a new project

2. Specify the path of the PAC reference

3. Add the control to the form

4. Add the event handling for the control

5. Upload the application to WP-9000-CE7
6. Execute the application on WP-9000-CE7

All main steps will be described in the following subsection.

In this tutorial, we will assume that you have installed WP-9000-CE7 SDK on PC and used the Visual
Studio 2008 for application development.
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4.3.1. Create a new project

The Visual C# project template is a composite control that you use in this example creates a new

project with this user control.

Step 1: Start Visual Studio 2008

"2

Step 2: On the File menu, point to New, and then click Project

Edit View Tools Test Window Help

New » | 5] Project. Ctrl+Shift+N
| Open » | @  WebSite.. Shift+Alt+N

Close ' | File.. Ctrl+N

Close Solution Project From Existing Code...

Save Selected Items  Ctrl+5
Save Selected Items As...
Save All Ctrl+Shift+5

® &t

Export Template..

W] | Page Setup..
3 | Print.. Ctrl+P
Recent Files »
Recent Projects »
Exit
WP-9000-CE7 Series User Manual, version 1.0.2 Page: 80

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved. < E-mail: service@icpdas.com




Step 3: In the Project types pane, expand Visual C# node and select Smart Device

Step 4: In the list of Templates, select Smart Device Project

Step 5: Specify a name and a location for the application and then click OK

— ——RRR N ———————————————_—_——_——————_—_—_—_mssssim_s—§m§m—m§—_mm_—_—_—_m—_m_m_m_m_m_m§m_ms§m§m§§_ms—§m§m§—§m_m§ms§§E§SE§Smmmma\sS\wewns

I.NEI' Framework 3.5 ]

Project types:

Templates:

Visual C++
Other Languages
Visual Basic

Visual C#
Windows
Web

MySQL
Office
Database
Reporting
Test

WCF
Workflow

Test Projects

Smart Device

Other Project Types

Visual Studio installed templates
ESmart Device Project
My Templates

2} Search Online Templates...

Solution Name:

A project for Smart Device applications. Choose target platform, Framework version, and template in the next dialog box.

Name: SDK_IH'FDI
Location: CA\Users\Administrator\Documents\Visual Studio 2008\Projects - Browse...
| Solution: [Create new Solution '] Create directory for solution

SDK_Info

OK

Cancel
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Step 6: In the Target platform, select Windows CE

Step 7: In the .NET Compact Framework version, select .NET Compact Framework
Version 3.5.

Tips & Warnings

Windows CE7 only supports .NET Compact Framework Version 3.5, if your
application uses .NET Compact Framework Version 2.0 there is no guarantee
that the program will function correctly.

Step 8: In the list of templates, select Device Application. Click OK

Target platform: lWindows CE v]
NET Compact Framework version: I.NET Compact Framework Version 3.5 ']
Templates:
= =
@ i = Er f alch
L@ @ % g E Description:
Device Class Console Control Empty ] .

Application  Library  Application  Library Project A project for creating a NET
Compact Framework 3.5 forms
application for Windows CE
Platform

i Download additonal emulator images and smart device SDKs... M
oK I l Cancel
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4.3.2. Specify the path of the PAC reference

The PAC SDK provides a complete solution to integrate with WP-9000-CE7 and it’s compatible with
Visual C#, Visual Basic.NET and C++. In order to use a component in your application, you must first
add a reference to it.

Stepl: Get the PACNET.dII

)
s+

PACNET.II

The PACNET.dIl can be found from the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.

CD:\WP-9000\SDK\PACNET\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/sdk/pacnet/

Step 2: On the Project menu, and then click Add Reference...

% SDK_Info - Microsoft Visual Studio (Administrator) I » ~-* J 3

File Edit View | Project| Build Debug Data Format Tools Test Window Help
Add Windows Form...
Add User Control...

Add Component...

Add Module...

Add Class..

Add New Item... Ctrl+Shift+A
Add Existing Item...  Shift+Alt+A

E L & BB E

Exclude From Project
Show All Files

Add Reference...

Add Web Reference...
Set as StartUp Project

&

+4 | Refresh Project Toolbox Items

Change Target Platform...
SDK_Info Properties... Alt+F7
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/sdk/pacnet/

Step 3: On the Browse tab and browse to where the PACNET.dIl are installed, and then
click OK

| .NET | Projects| Browse |Recent
Lookin: | PACNET ~ @7 &~
Mame r Date modified
| @) PACNET.II 2014/5/30
<« | Il 3
File name: : PACNET -
Files oftype: @ |Component Files (*.d11¥ 11b;¥* olb;* ocxs¥. exe) -
OK ‘ ‘ Cancel
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4.3.3. Add the control to the form

You can drag various controls from the Toolbox onto the form. These controls are not really "live";

they are just images that are convenient to move around on the form into a precise location.

After you add a control to your form, you can use the Properties window to set its properties, such
as background color and default text. The values that you specify in the Properties window are the
initial values that will be assigned to that property when the control is created at run time.

Step 1: On the Toolbox panel, drag a Button control onto the form

e
Toolbox + 1 X
All Device Controls -

B Common Device Contr...
k Pointer

&) Button | \‘
CheckBox

=5 ComboBox

T DateTimePicker
A Label

A LinkLabel

8 ListBox

:: ListView

F] MonthCalendar
£ NumericUpDown
[ PictureBox

@ ProgressBar

® RadioButton

+|+ Splitter

TextBox

% TrackBar

i TreeView

[T WebBrowser
Device Containers L
Device Menus & Toolb...
Device Data

Device Components
Device Dialogs

B General -~

MS.. [T [BC. [ZP. [FR. |
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Step 2: On the Properties panel, type Check the SDK version in the Text field

Properties

Buttonl System.Windows.Forms.Button

o=]4) [B]# |E

=B Appearance o
BackColor |:| Control

Font Tahoma, 10pt !
ForeColor . ControlText =

Check the SDK Version| m___;‘"

= Behavior
ContextMenu (none)
DialogResult None
Enabled True

a Check the SDK Version |
LF )

TabIndex 0
TabStop True -
Text

The text contained in the control.
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4.3.4. Add the event handling for the control

You have finished the design stage of your application and are at the point when you can start
adding some code to provide the program's functionality.

Step 1: Double-click the button on the form

% Check the SDK Version E

Step 2: Inserting the following code

byte[] data = new byte[30];
PACNET.Sys.GetSDKVersion(data);

MessageBox.Show(PACNET.MISC.WideString(data));

"“"’“_\m/l\-""";-'\fm\*ﬁ‘a\ N e e A VN A Sy

= private void buttonl Click{object sender, Eventhros el
{

bvte[] data = new hyvte[30];

PACHET .5vs .GetSDEYersionidata);

MessapeBox .Show(PACHET MISC WideString{data));

- ﬂwdﬁ

Tips & Warnings

A The “PACNET” of “using PACNET” is case- sensitive.
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4.3.5. Upload the application to WP-9000-CE7

WP-9000-CE7 supports FTP server service. You can upload files to WP-9000-CE7 or download files
from a public FTP server.

Step 1: On the Build menu, and then click Build [Project Name]

File Edit View Project |Build | Debug Data Format Tools Test Window Help
Build Solution F7
Rebuild Solution  Ctrl+Alt+F7

Deploy Solution
Clean Solution
% Build SDK Info
Rebuild SDK_Info
Deploy SDK_Info
Clean SDK_Info

Configuration Manager...
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Step 2: Open the browser and type the IP address of WP-9000-CE7

Step 3: Upload the application and the corresponding PACNET.dII files to WP-9000-CE7

Tips & Warnings

A For applications programming in C# and VB.net with .net compact
framework, when executing these application on WP-9000-CE7, the

corresponding PACNET.dIl must be in the same directory as the .exe file.

| File Edit View Go Favorites ||”J|£
”]Agldress | YTemp

= O

PACMET SDK_Info

R/\U/v‘“"\

N N YA
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4.3.6. Execute the application on WP-9000-CE7

After uploading the application to WP-9000-CE7, you can just double-click it on WP-9000-CE7 to

execute it.

S0k _Info
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4.4. First WP-9000-CE7 Program in Visual C++

The best way to learn programming with WP-9000-CE7 is to actually create a WP-9000-CE7

program.

The example below demonstrates how to create a demo program running on WP-9000-CE7 with
Visual C++.

To create a demo program with Visual C# that includes the following main steps:

1. Create a new project

2. Configure the Platform

3. Include the Header files and Libraries of the PAC SDK
4. Add the control to the form

5. Add the event handling for the control

6. Upload the application to WP-9000-CE7

7. Execute the application on WP-9000-CE7

All main steps will be described in the following subsection.

In this tutorial, we will assume that you have installed WP-9000-CE7 SDK on PC and used the Visual
Studio 2008 for application development.
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4.4.1. Create a new project

The Visual C# project template is a composite control that you use in this example creates a new

project with this user control.

Step 1: Start Visual Studio 2008

"2

Step 2: On the File menu, point to New, and then click Project

Edit View Tools Test Window Help

New » | 5] Project. Ctrl+Shift+N
| Open » | @  WebSite.. Shift+Alt+N

Close ' | File.. Ctrl+N

Close Solution Project From Existing Code...

Save Selected Items  Ctrl+5
Save Selected Items As...
Save All Ctrl+Shift+5

® &t

Export Template..

W] | Page Setup..
3 | Print.. Ctrl+P
Recent Files »
Recent Projects »
Exit
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Step 3: In the Project types pane, expand Visual C++ node and select Smart Device

Step 4: In the list of Templates, select MFC Smart Device Application

Step 5: Specify a name and a location for the application and then click OK

@ . = — 7
New Project 5 = &u
- - - — - — — . - -
Project types: Templates: NET Framework 3.5 ~ ]

Visual C++ Visual Studio installed templates
ATL ﬁATL Smart Device Project ﬁ]‘HMFC Smart Device ActiveX Control
CLR '_i'jEMFC Smart Device Application _ijEMFC Smart Device DLL
Eﬂiréeral _-EWinSZ Smart Device Project
Smart Device My Templates
Test :1d Search Online Templates... ]
Win32

Other Languages

Other Project Types !

Test Projects

An application for Windows Mobile and other Windows CE-based devices that uses the Microsoft Foundation Class Library

Name: SDK_Infq|
| Location: C\Users\Administrator\Documents\Visual Studio 2008\Projects - Browse...
Solution Name: SDK_Info Create directory for solution
[l
OK I l Cancel l
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Step 6: On the first page of the wizard, click Next

MFC Smart Device Application Wizard - SDK_Info M

E- Welcome to the MFC Smart Device Application Wizard

These are the current project settings:
® Windows Mobile 5.0 Pocket PC SDK Platform
# Single document interface

Overview

Platforms

Application Type

Document Template Strings Click Finish from any window to accept the current settings.

After you create the project, see the project's readme.tu file for information about the project features

User Interface Features
and files that are generated.

Advanced Features

Generated Classes

<F’re‘-,fi0us|f Next = i’ Finish ” Cancel

Step 7: On the next page of the wizard, select AM335x_WINCE7_SDK to be added to the
project, and then click Next

MFC Smart Device Application Wizard - SDK_Info M

=== platforms

Overview Select platform SDKs to be added to the current project.

Platforms

Application Type
Document Template Strings
b 9 Installed SDKs: Selected SDKs:

AM335x_WINCE7_SDK

User Interface Features Pocket PC 2003 |_|
Smartphone 2003 z
advancediisatiies Windows Mobile 5.0 Pocket PC SDK

Generated Classes Windows Mobile 5.0 Smartphone S

Bl

Instruction sets: ARMwv4I, ARMv4I

’* AM335x_WINCE7_SDK

<Previou5” Next > ” Finish ” Cancel ]

L
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Step 8: On the next page of the wizard, select Dialog based, and then click next

MFC Smart Device Application Wizard - SDK _Info EE

Application Type

Application type:

Overview

Flatforms ) Single document

Application Type @ Dialog based

Document Template Strings O Single document with DocList

User Interface Features
Document/View architecture support
Advanced Features

Resource language:

|=x (=)

Generated Classes

Use of MFC:

() Use MFC in a shared DLL

@) Use MFC in a static library

<Previou5” Next = ” Finish ” Cancel

Step 9: On the next page of the wizard, click next

L

User Interface Features

Command bar:

Overview

Platforms (©) Menus only

Application Type ' Menus and buttons
Document Template Strings

User Interface Features L Status bar

Advanced Features

MFC Smart Device Application Wizard - SDK _Info EE

Dialog title:
Generated Classes SDK_Info
| <Previou5” MNext = ” Finish ” Cancel ]
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Step 10: On the next page of the wizard, click next

MFC Smart Device Application Wizard - SDK _Info

Advanced Features

Overview Advanced features:
Platforms U windows Help
Application Type O Printing and print preview

Document Template Strings Ok

User Interface Features B windows sockets

Advanced Features
Number of files on recent file list:

Generated Classes

<Previou5” Next = ” Finish ” Cancel

" [ . . - J

Step 11: On the next page of the wizard, click Finish

-
MFC Smart Device Application Wizard - SDK _Info
Generated Classes
Overview Generated classes:
Platforms
CSDK_InfoDlg
Application Type
Document Template Strings
User Interface Features Tz e Ly
advancediisatiies CSDK_InfoApp [sDK_1nfo.h |
Generated Classes
Base class: .cpp file:
CWinApp |SDK_Inf0.cpp |
|
<previous|| 1ed - || Fnish || cancel |
h [ i 4 - S
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4.4.2. Configure the Platform

When developing applications by using Visual C++, you must configure the Platform to indicate
what platform and device you intend to download the application to. Before you deploy your
project, check the platform.

On the Debug configuration toolbar, select Release and select AM335x_WINCE7_SDK(ARMv4I) as

shown in the following illustration.

\

TR AT B Ba @ |~ ~ 5~ - -« \#
AR A" B I NN & ([PRC Amaasxb_sm
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4.4.3. Specify the Libraries of the PAC SDK

The PAC SDK provides the PACSDK libraries with WP-9000-CE7.
It’s compatible with C++. In order to use a component in your application, you must first add a
reference to it.

Step 1: On the View menu, and then click Property Pages

File Edit | View | Project Build Debug Tools Test Window Help

=y | Solution Explorer Ctrl+Alt+L
) | Bookmark Window Ctrl+K, Ctrl+W
5% | Class View Ctrl+Shift+C
[ & Code Definition Window  Ctrl+Shift+V
=% Object Browser Ctrl+Alt+)
=] | Output Alt+2
Property Manager
4| | Resource View Ctrl+Shift+E
%+ | Toolbox Ctrl+Alt+X
Find Results »
Other Windows »
Toolbars »
= | Full Screen Shift+Alt+Enter
&1 | Navigate Backward Ctrl+-
5 | Navigate Forward Ctrl+Shift+-
Next Task
Previous Task
Property Pages
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Step 2: In left pane, click Linker, and then click Input

Step 3: In the right pane, Type PACSDK.lib in the Additional Dependencies item

SDK_Info Property Pages .T‘ . u 2 « a4 44 m
Configuration: lActive(Debug) V] Platform: lActive(AMSSSx_MNCE?_SDK f Vl l Configuration Manager... ] '
Common Properties Additional Dependencies PACSDK.lib (]
Configuration Properti Ignore All Default Libraries No
General Ignore Specific Library
Debugging Module Definition File
Deployment Add Module to Assembly
C/C++ Embed Managed Resource File
i Linker Force Symbol References
General Delay Loaded DLLs
i qu . Assembly Link Resource
Manifest File
Debugging
System
Optimization
Embedded IDL
Advanced
Command Line
Resources

AML Document Gen
| Browse Information
Build Events
Custom Build Step
Authenticode Signir

Additional Dependencies
Specifies additional items to add to the link line (ex: kernel32.lib); configuration specific.

r [ oK ” Cancel ] Apply
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4.4.4. Add the control to the form

You can drag various controls from the Toolbox onto the form. These controls are not really "live";

they are just images that are convenient to move around on the form into a precise location.

After you add a control to your form, you can use the Properties window to set its properties, such

as background color and default text. The values that you specify in the Properties window are the

initial values that will be assigned to that property when the control is created at run time.

Step 1: On the View menu, and then click Resource View

File Edit | View | Project Build Debug Tools Test Window Help

id @ [§ ol & O &4 [

|55

*

Code Ctrl+Alt+0
Solution Explorer Ctrl+Alt+L
Bookmark Window Ctrl+K, Ctrl+W
Class View Ctrl+Shift+C

Code Definition Window  Ctrl+Shift+\V/

Object Browser Ctrl+Alt+)
Output Alt+2
Property Manager

Resource View Ctrl+Shift+E
Toolbox Ctrl+Alt+X
Find Results »
Other Windows »
Toolbars »
Full Screen Shift+Alt+Enter
Navigate Backward Ctrl+-
Navigate Forward Ctrl+Shift+-

Mext Task

Previous Task

Property Pages

WP-9000-CE7 Series User Manual, version 1.0.2

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved.

Page: 100

DA< E-mail: service@icpdas.com



Step 2: In the Resource View Panel, Expand the [Project name].rc file and then expand
the Dialog item to click the plug-in dialog

=-izd SDK_Info
=-£3 SDK_Info.rc

ﬁ Icon

; . 'SDKnfo.rc - IDD_S... - Dialog| v X
w3 Version
LI||||J
| SDK_Info (=]
-
| TODO: Place dilog controls here. L
< | I | -
Resource... |3 Toolbox |2 Propert)| | -
-

Step 3: On the Toolbox panel, drag a Button control onto the form

H
B Dialog Editor -
k Pointer r|
||:I Button |/
¥ Check Box
abl Edit Control
Ef Combo Box
EEl List Box y
9 Group Box |m-| SDK_Info @
% Radio Button _—-']
Aa Static Text I = = u
Picture Control - ::

B Horizontal Scroll Bar : TODO: Place dialog contrals here,
B Wertical Scroll Bar
4= Slider Control 1

EResaUrce: | Toolbox [Propery.

"_SDK_Info.rc - IDD_S... - Dialog v X
u...|....|....|....|....d

A Ll [N)

L.
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Step 4: On the Properties panel, type Check the SDK version in the Caption field

Properties - 1 X
IDC_BUTTONI (Button Control) ICeButtonEc -
I EIFA=
E Appearance
Caption Check the SDK version
Client Edge False
Horizontal Alignmer Default
Modal Frame False
Multiline False
Notify False
Static Edge False
Vertical Alignment Default
E Behavior
Default Button False
Disabled False
Owner Draw False
Visible True
E Misc
(Name) IDC_BUTTOM1 (Button C

rou WWW
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4.4.5. Add the event handling for the control

You have finished the design stage of your application and are at the point when you can start
adding some code to provide the program's functionality.

Step 1: Double-click the button on the form

@] SDK_Info (&R ]

!

u || |
s Checkthe SDE vesion  |m
] [ ] ]

TODD: Flace dialog controls here,

Step 2: Inserting the following code
char sdk_version[32];
TCHAR buf[32];
pac_GetSDKVersion(sdk_version);
pac_AnsiToWideString(sdk_version, buf);

MessageBox(buf,0,MB_OK);

Y YV e N i IV VAN

Hwvoid CSDE InfaoDllg::0nBaClickedButtonl()
{

\J

HfOTODD: Add wour control notification handler code here
char sdk_version[3Z2];

TCHAR buf[3Z2];

pac_GetSDEVersionisdl wersion);
pac_hAns1ToWideString{sdk_version,buf);
MessageBox (huf ,0,MB_OK);

\u_m'-....uuf \b"’ J v

}
Hhkgumwnu”“J“gfrﬂFﬁﬂxxFug”’”““\ujfwwxv““nhfvfw“”“\fh“”‘ﬂvv=—f
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Step 2: Inserting the following code into the header area

#tinclude “PACSDK.h”

B/f SDE_Infallg.cpp @ tmplementation filé}
H y
N n n g
#include "stdafx.h
Finclude "SDE _Infa.k" <;
#Finclude "SDE Infallz. B ¢
#Finclode "PACSDE.L" fE;
S#i1fdef _DEBUG
ﬁww%;w
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4.4.6. Upload the application to WP-9000-CE7

WP-9000-CE7 supports FTP server service. You can upload files to WP-9000-CE7 or download files
from a public FTP server.

Step 1: On the Build menu, and then click Build [Project Name]

File Edit View ijectm Debug Tools Test Window Help
Build Solution F7
Rebuild Solution  Ctrl+Alt+F7
Deploy Solution

Clean Solution
#¥ Build SDK _Info
Rebuild SDK_Info
Deploy SDK_Info
Clean SDK_Info

Project Only »
Batch Build...
Configuration Manager...
% | Compile Ctrl+F7
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Step 2: Open the browser and type the IP address of WP-9000-CE7

Step 3: Upload the application to WP-9000-CE7

Ble Edit View Go Favorites | [['&
[Jagdress[ireme

O

SDK_Info
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4.4.7. Execute the application on WP-9000-CE7

After uploading the application to WP-9000-CE7, you can just double-click it on WP-9000-CE7 to

execute it.

SDK_Info
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5. 1/0 Expansion Modules and SDKs Selection

This chapter describes how to select a suitable expansion I/O module and the corresponding SDK

library to be used for developing programs on WP-9000-CE7.

WP-9000-CE7 provides the following I/O expansion buses:

M-7K RU-87Pn

ET-7K ET-87Pn I-9K/I-97K series 1/O modules

1. RS-485 (I-7000 series and M-7000 series)

[-7000, M-7000, RU-87Pn and high profile I-87K series modules connect to WP-9000-CE7 via a
twisted-pair, multi-drop, 2-wire RS-485 network.

> 1-7000 series I1/0 modules

Module Native SDK .NET CF SDK
I-7000 series PACSDK.dII PACNET.AII
I-7000 series with 1-7088 (D) PACSDK_PWM.dII PACNET.AII

For full details regarding 1-7000 series |/0O modules and its demos, please refer to:
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/pac/applicabled demo for 7k module.

pdf
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/pac/applicabled_demo_for_7k_module.pdf
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/pac/applicabled_demo_for_7k_module.pdf

» M-7000 series I/0 modules

Native SDK .NET CF SDK

M-7000 series Modbus Demo Modbus Demo

For more detailed information about M-7000 series modules using Modbus protocol and its demos,
please refer to:
CD:\Wp-9000\demo\nModbus\

» RU-87Pn + I-87K series I/O modules

Module Native SDK .NET CF SDK

RU-87Pn+-87K series PACSDK.dII PACNET.II

» Other Specified 1/0

Module Native SDK .NET CF SDK

Others PACSDK.dll PACNET.II

2. Ethernet (ET-7000 series and I-8KE4/8-MTCP)

The Ethernet I/O devices available include ET-7000and I-8KE4/8-MTCP, and support either the
DCON or the Modbus/TCP communication protocol.

Module Native SDK .NET CF SDK
M-7000 series Modbus Demo Modbus Demo
I-8KE4/8-MTCP Modbus Demo Modbus Demo

For more detailed information about ET-7000 and I-8KE4/8-MTCP series modules using
Modbus protocol and its demos, please refer to:
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/demo/nmodbus/

3. Locall/O
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WP-9000-CE7 has 2/4/8 expansion slot(s) that can be used to add expansion 1/O modules. The
expansion I/0 modules can be divided into two categories: High Profile 1-9K series I/0 modules and
High profile I-97K series I/O modules. The following indicates the appropriate SDK library to be

used for I/O modules.

> General 1-8K/I-87K series I/O module

Module Native SDK .NET CF SDK ‘
I-9K series PACSDK.dII PACNET.dII
I-97K series PACSDK.dII PACNET.dII
I-9K series with PWM PACSDK_PWM.dII PACNET.dII
I-97K series with PWM PACSDK_PWM.dII PACNET.dII

For full details regarding 1-97K series I/0O modules and its demos, please refer to:

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-9000/demo/pac/applicabled demo for 97k
module.pdf

» Other Specified 1/0

Module Native SDK .NET CF SDK ‘
1-9014 pac_i8014W.dll pac_i8014WNet.dll
1-9014C pac_i8017HW.dII pac_i8017HWNet.dll
1-9017 pac_i8017HW.dII pac_i8017HWNet.dll

[-9017-15 pac_i8024W.dll pac8024WNet.dll
1-9024 pac_i8028U.dll pac_i8028UNet.dll
1-9024U pac_i8028U.dll pac_i8028UNet.dll
1-9028U pac_i8048W.dl| pac_i8048WNet.dll
1-9048 pac_i8172W.dll pac8172WNet.dll

4. FRnet
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FRnet is an innovative industrial field bus technology that uses twisted pair cable as the
transmission medium. The status of all I/O devices is updated on a fixed cycle, no matter how

many FRnet I/0O modules are connected to the FRnet network.

Module Native SDK .NET CF SDK
1-9172 pac_ig014w.dll pac_i8014WNet.dll
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6. APl Resources and Demo References

This chapter provides a brief overview of PAC standard APIs and demos that have been designed
for WP-9000-CE7 from the PAC SDK package.

ICP DAS provides a set of demos in different programming languages. You can examine the demo
codes, which includes numerous comments, to familiarize yourself with the PAC APIs. This will

allow developing your own applications quickly by modifying these demo programs.

For full usage information regarding the description, prototype and the arguments of the functions,
please refer to the “PAC Standard APl Manual”

E PAC Standard API Manual 1.1.1. pdf - Adobe Acrobat Pro

WEE REE wRE) \E A *
- | B EOPFPE| el BT g - |
Boat P zanll=1 o w= | &w
Ll = B 2. PAC API Functions s

‘EP B- e R
2P 21 Systern Infarmation AP A IE‘ = @ m @ 1

ﬁ EF 2.1.1, pac_GetModuleMame

[P pac_cetRotaryiD = fo i ad

- 2.1, System Information APT il

Lfﬂ Paia pac_GetSerialNurmber

Pa1a pac_GetsShKversion G 2.1.1. pac_GeﬂWDduleName

EF 2.1.5. pac_ChangeSiot

EF 2.1.6, pac_CheckSDK\Version E paE—GEtRDtarYID

gii; "ac-z'Dg‘E'iE"‘s_“s [P 2.1.3. pac_cetSerialNumber E

L8, pac_Ge Brsion
E;zw pac_GetvacAddress [:P 2.1.4, pac_GetsDENersion
2,110, pac_ReBoot

[P 2.1.11. Pac_GetCFUVersion m 2.1.5. pac_ChangeSlot

[P 2.1.12, Pac_EnableLED )

[P 2,115, Pac_crableLDs [:P 2.1.6. pac_CheckSDK\ersion

EF 2.1.14, pac_BackwardCompatible E 21? [JaE_MDdU'EE}{iStE

EF 2.1.15. pac_GetEbootYersion

[P 2116, pac_cetcommapning I:F 2.1.8. paE_GetDSH-’ErSiDn

Paii7 pac_GetModuleType

EF 2.1.18. pac_GetPachetVersion E 2'1'9' paE—GENaE'&‘ddrESS

Ez‘l.lg. pac_PuzzerBeep - E =910, pac_ReE-DDt v

[ 2.1.11. Pac_getcPUversion

[P 2.1.12. Pac_EnableLED

[P 2.1.13. Pac_EnablelEDs

[P 2.1.14. pac_BackwardCormpatible
[:P 2.1.15. pac_GetEhootersion

[P 2.1.16. pac_GetcomMapping

[P 2117 pac_GetvoduleType

[:F 2.1.18. pac_ietPacNetversion

[:F 2.1,19. pac_BPuzzerBeep
(il
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6.1. PAC Standard APIs for System Operation

The diagram below shows the set of each system operation API provided in the PACSDK.

[ ! » System Information » Watchdog
| I » Backplane Access >» UART
! » Backlight » Registry
— >» Interrupt » Buzzer
» Memory Access >» LED

System Operation
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6.1.1. VB.NET Demos for PAC Standard APIs

The PAC SDK includes the following demos that demonstrate the use of the PAC Standard APIs in a
VB.NET language environment.

The following demos can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.
CD:\WP-9000\Demo\PAC\Vb.net\Standard\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/demo/pac/vb.net/standard/

Explanation
buzzer buzzer Shows how to make a simple buzzer beep.
) ) ) ) Retrieves information about the OS version, CPU
Devicelnformation Devicelnformation ) )
version, SDK version, etc.
Retrieves information about the status of the
GetRotaryIlD GetRotaryIlD )

rotary switch
Shows how to read/write data values from/to

Memory Memory
the EEPROM or the backplane of the SRAM

MultiRT MultiRT Shows how to manage the SD
Writes the managed cod for the rich graphical

RealTimeTest RealTimeTest user interface that does not require true
real-time performance
) ) Shows how to read/write data values from/to

Registry Registry .
the registry
Shows how to read the name of a local I/O

UART UART )
modules via a UART
Displays information about how to operate the
WatchDog WatchDog
watchdog
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6.1.2. C# Demos for PAC Standard APIs

The PAC SDK includes the following demos that demonstrate the use of the PAC Standard APIs in a

C# language environment.

The following demos can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.
CD:\WP-9000\Demo\PAC\C#\Standard\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/demo/pac/c%23/standard/

Explanation
buzzer buzzer Shows how to make a simple buzzer beep.
) ) ) ) Retrieves information about the OS version, CPU
Devicelnformation Devicelnformation ) )
version, SDK version, etc.
Retrieves information about the status of the
GetRotaryIlD GetRotaryIlD )

rotary switch
Shows how to read/write data values from/to

Memory Memory
the EEPROM or the backplane of the SRAM

MultiRT MultiRT Shows how to manage the SD
Writes the managed cod for the rich graphical

RealTimeTest RealTimeTest user interface that does not require true
real-time performance
) ) Shows how to read/write data values from/to

Registry Registry .
the registry
Shows how to read the name of a local I/O

UART UART )
modules via a UART
Displays information about how to operate the
WatchDog WatchDog
watchdog
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6.1.3. Visual C++ Demos for PAC Standard APIs

The PAC SDK includes the following demos that demonstrate the use of the PAC Standard APIs in a

Visual C++ language environment.

The following demos can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.
CD:\WP-9000\Demo\PAC\Vc2008\Standard\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/demo/pac/vc2008/standard/

Folder Explanation
buzzer buzzer Shows how to make a simple buzzer beep.
) ) ) ) Retrieves information about the OS version, CPU
Devicelnformation Devicelnformation ) )
version, SDK version, etc.
Retrieves information about the status of the
GetRotarylD GetRotaryIlD )
rotary switch
Shows how to read/write data values from/to
Memory Memory
the EEPROM or the backplane of the SRAM
MultiRT MultiRT Shows how to manage the SD
Writes the managed cod for the rich graphical
RealTimeTest RealTimeTest user interface that does not require true
real-time performance
) ) Shows how to read/write data values from/to
Registry Registry .
the registry
Shows how to read the name of a local I/O
UART UART )
modules via a UART
Displays information about how to operate the
WatchDog WatchDog
watchdog
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6.2. PAC Standard APIs for PAC Expansion 1/O

The diagram below shows the types of the PAC IO APIs provided in the PACSDK.

PACIO

Remote I/0 Local 1/0

TR Ll
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6.2.1. VB.NET Demos for PAC Expansion I/O

The PAC SDK includes the following demos that demonstrate the use of the PAC expansion I/O in a
VB.NET language environment.

The following demos can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.
CD:\WP-9000\Demo\PAC\Vb.net\IO\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/demo/pac/vb.net/io/

Folder Demo Explanation

Shows how to send/receive a command/response application.
7k87k_basic This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Shows how to read the Al values of Al module.
7k87k_ai This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Shows how to write the AO values to AO module.
7k87k_ao This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Remote
Shows how to read the DI values of DI module.

7k87k_di This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Shows how to write the DO values to DO module.

7k87k_do This demo program is used by 7K or 87K series

Al modules which connected through a COM port.

Shows how to read the DI and the DO values of the DIO module.
7k87k_dio This demo program is used by 7K or 87K series

Al modules which connected through a COM port.
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6.2.2. C# Demos for PAC Expansion I/O

The PAC SDK includes the following demos that demonstrate the use of the PAC expansion I/O in a

C# language environment.

The following demos can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.
CD:\WP-9000\Demo\PAC\C#\IO\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/demo/pac/c%23/io/

Folder Demo Explanation

Shows how to send/receive a command/response application.
7k87k_basic This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Shows how to read the Al values of Al module.
7k87k_ai This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Shows how to write the AO values to AO module.
7k87k_ao This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Remote
Shows how to read the DI values of DI module.

7k87k_di This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Shows how to write the DO values to DO module.

7k87k_do This demo program is used by 7K or 87K series

Al modules which connected through a COM port.

Shows how to read the DI and the DO values of the DIO module.
7k87k_dio This demo program is used by 7K or 87K series

Al modules which connected through a COM port.
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6.2.3. Visual C++ Demos for PAC Expansion I/O

The PAC SDK includes the following demos that demonstrate the use of the PAC expansion I/O in a

C# language environment.

The following demos can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.
CD:\WP-9000\Demo\PAC\Vc2008\I0\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/demo/pac/vc2008/io/

Folder Demo Explanation

Shows how to send/receive a command/response application.
7k87k_basic This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Shows how to read the Al values of Al module.
7k87k_ai This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Shows how to write the AO values to AO module.
7k87k_ao This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Remote
Shows how to read the DI values of DI module.

7k87k_di This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Shows how to write the DO values to DO module.

7k87k_do This demo program is used by 7K or 87K series

Al modules which connected through a COM port.

Shows how to read the DI and the DO values of the DIO module.
7k87k_dio This demo program is used by 7K or 87K series

Al modules which connected through a COM port.
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7. WP-9000-CE7 Updates

This chapter provides a guided tour that demonstrates the steps needed to update the
WP-9000-CE7 OS and SDKs.

ICP DAS will continue to add additional features to WP-9000-CE7 SDK and OS in the future, so we
advise you to periodically check the ICP DAS web site for the latest updates.

The file location of the OS and SDK
Both the files of OS updates and SDK updates can be found on the CD that was provided with the

package or by downloading the latest version from ICP DAS web site.

CD:\wp-9000\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/

OS_Image

> The files of OS updates

update_from_Micro_SD

update_from_file

> The files of SDK updates

PlatformSDK |y
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7.1. OS Updates

The latest version of the WP-9000-CE7 OS image can be found separately on the CD that was

provided with the package or by downloading the latest version from ICP DAS web site.

CD:\wp-9000\0S_Image\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/os_image/

update_from_Eshell_or_Micro_SD

— update_from_file

There are two ways to update the OS:

OS image

update_from_Eshell ¥8

update_from _file or_Micro_SD

1. OS updates from Eshell (Please refer to section 7.1.1)
(We recommend that you use this one for more quicker and easier to update)

2. OS updates from SD (Please refer to section 7.1.2)
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7.1.1. OS Updates from Eshell

By default, the OS update is updated via a LAN.
Before updating the OS, make sure the LAN is
connected to PC.

Step 1: Get the latest version of the installation package file and then unzip it
The latest version of the installation package file can be found from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/WP-9000-CE7/os image/update fro
m_eshell or micro sd\

Step 2: Run the registry clear.exe

The registry.exe can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.

CD:\WP-9000\PC_Tools\Eshell

http://ftp.icpdas.com/pub/cd/winpac_am335x/WP-9000-CE7/pc tools/eshell

Step 3: Place the rotary switch in position 3, OS update mode
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Step 4: Run the ESHELL.exe, and then restart the WP-9000-CE7-CE7

The ESHELL.exe can be found on the CD that was provided with the
package or by downloading the latest version from ICP DAS web site. ESHELL

CD:\WP-9000\PC_Tools\Eshell

http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/pc_tools/eshell

Step 5: Select the device which you want to update the OS image, and then click OK

Select the device name which you want to update the OS image from the list.

Select Device

Enter Device Mame:

[WINPAC

Cancel I
Or Select Fram the List

Reset devices to
automatically put
names on the
hizt.

Step 6: Select the latest version of the OS image file

Look inc | I3 WPk _SOR40RT Toii 1 00d_m

| h;?ﬂ (WK b \’_\\/

[hocumends
v M Wisbews OF Tabag Shelll - VF_S6600 ARl _TyW ol A Dl colwp TI00_cr MT00
EB [ Blé Jook [hhoos Yew ol
Deskiop S Al ] = w| &
OF_ESEUE | BESTIGART DEFiGE 0,8, BFG TA.01 0,50, MRCT SEERTFErasm

Srwnleading " ViR avod_ PVHaFE0 napdastvp - T E_crt NS imegeep - FluTapdate_fron_[nbe 1m0

| Lunplog Na Lnage s WP_NGAPE ...
.---"III JEinnrining e oP_skall ecing Diherast, .,

My Documents

My Compater i 5
File narne: NE BIN

My Hetwaek
Files of types: NK Images (*
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Step 7: Once the procedure is completed, the “Warning !” dialog box will appear as
below shown, then turn the rotary switch in position 0, normal mode

YWarning

"': Reboot this device right nowy |
L Flease turn the rotary switch to 0 - normal

.
Step 8: Click the OK button TTE T
2 m_‘ A
IR i
i
¥¥arning ' \i‘ ﬁ ®
v @ L
":, Reboot this device right nowe ! e
L Flease turn the rotary switch to 0 - normal

Step 9: Check the OS version

Run the PAC Utility, and then select the Device Information tab to check the current

OS version.
PAC Utility
PAC Utility [1.2.1.4] M [=]
[General I General2 IDispIay I IP Config INetwork |DewceInf0rmat|Dn| Auto Execution I Ratary Exe_{] » |
Slot 1: l:l Module(CPLY Type: | |
Slat 2: |:| Serial Number : [p1-82-4D-06-18-00-00-D8 |
Slot 3: l:l Backplane Yersion: | |
Slot 4: |:| CPU Yersion: [tooa |
Slot 5: |:| 05 Yersion: [10.11, 2msa0m0 09536 |
Sote: [ ]  Ebootversion: [12.10, 2msa0/22 16:260 |
Stz [ ] METCF Version: [3.5.7338.00 |
SQL CE Version: [3581540 |
PACSDK Version:  [4.3.34 |
CPU Temperature: | |
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7.1.2. OS updates using SD

The SD card can be used to reinstall the WP-9000-CE7 OS image to factory default settings in the
event of the WP-9000-CE7 failure.

Step 1: Get the latest version of the installation package file, then unzip the file, and then
copy them to SD card

The latest version of the installation package file can be found from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/os image/update from es

hell or micro sd\

& WP523x 20140821 Ver.1.0.0.4 ml

File Edit “ew Favortes Tools Help

eBack - J l.’i /_ﬁ) Search [l Folders =Y o
Address |@ C:\update_frnm_Es‘ne]l_nr_Mil:m_SD\WPSZBX_ZD140821{\

EBOOTHD nbili EEOOTSD.nb
IHED 3% NED #3%
i 1256 KB ] 256 KB

MLO NE bin mg-’»o
WE Apple Macin :
B4 KB 65,109 KB e > Adapter

[ ALDRSD b0
Ho HLLRYD.
128 KB 1:}3{}-:;*

Step 2: Plug the SD card into SD slot

A

icro
m<eS

Adapter
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Step 3: Turn the rotary switch in position 5,
OS update mode

PAC Utility [1.2.1.4]

Save %r

Save and Reboot pnfig | Netwark 37

Step 4: Reboot the WP-9000-CE7 Reboot 4
)

Restare Utility Default Settings 1’3

Exit _{’)

AC UtiP

T

Step 5: Wait a few minutes for the following
desktop to be displayed

Step 6: Turn the rotary switch in position 0,

normal mode

@; Q -y i
{
| + O O @ O + O + +
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Step 7: Reboot the WP-9000-CE7

PAC Utility [1.2.1.4]

iﬁE Help

i
Save %‘l’
Save and Reboot £l | EEE 7

Reboot

Restore Utility Default Settings
Exit

Step 8: Check the OS version

Run the PAC Utility, and then select the Device Information tab to check the current

OS version.

X,
PAC_Utility

M [=] B3

PAC Utility [1.2.1.4]

File Help

Slot 1:
Slot 2:
Slot 3:
Slot 4:
Slot 5:
Slot 6:

Slot 7:

Serial Mumber:

CPU Yersion:
05 Version:

Eboot Yersion:

UL

MET CF Yersion:
SOL CE Yersion:

PACSDE Yersion:

CPU Temperature:

Maodule(CPL) Type:

Backplane Version:

|
|o1-62-4p-06-18-00-00-D8. |
| |

|

[tooa

[10.1.1, 2015/10/30 09:365 |

[12.1.0, 201540722 16:26:0 |

[35.7338.00 |

[35.8154.0

|
[433.4 |
|

WP-9000-CE7 Series User Manual, version 1.0.2

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved.

Page: 128

DA< E-mail: service@icpdas.com




7.2. SDK Updates

SDK update is a part of the WP-9000-CE7 update services to provide additional and more efficient
features and functionality for WP-9000-CE7 operating system.

The SDK update files can be found separately on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.

CD:\wp-9000\SDK\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/sdk/

— .
T
— .
=
—
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7.2.1. SDK Updates for VB.NET or C#

The SDK can be updated by changing the SDK file.

Step 1: Get the latest version of the PACNET.dII file

The latest version of the PACNET.dII file can be obtained from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/sdk/pacnet/

Step 2: Copy the latest version of PACNet.dll file to PC and WP-9000-CE7
The PACNET.dII file on PC can be placed anywhere only the solution can reference it.

The PACNET.dII file on WP-9000-CE7 is located at the same directory as the .exe file.
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7.2.2. SDK Updates for VB.NET or Visual C++

The SDK can be updated by changing the SDK file.

Step 1: Get the latest version of the VC++ components
The latest version of the VC++ components can be obtained from:

http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-9000/sdk/pacsdk/

Step 2: Copy the latest version of header files and libraries to PC
The header files are located at:
C:\Program Files\Windows CE Tools\SDKs\AM335x_WINCE7_SDK\Include\Armv4i
The libraries are located at:

C:\Program Files\Windows CE Tools\SDKs\AM335x_WINCE7_SDK\Lib\ARMv4|

Step 3: Copy the latest version of DLL files to WinPAC
The DLL files are located at:

\System_Disk\ICPDAS\System
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8. WP-9000-CE7 Download Center

This chapter provides a brief introduction of the WP-9000-CE7 download center.

WP-9000-CE7 has a download center where you can access the latest version of the software, tools,

demo programs, and related information.

The WP-9000-CE7 Download Center can be found at:
http://www.icpdas.com/root/support/download/pac/wp-9000-ce7/wp-9000-ce7 download os i

mages.html

WP-92000-CE7 Download Center

Mote:

When you download the software programs, you should notice if the programs conform to your
machine. Before you download any program, please read the notes of each online program first to
avoid the confused situztion.

-

05 images ( SOk TUtTITt{.r &TmIsT Damo T Documents T System DTskT FAQ

Note:
Before vou download the software programs, you should notice if the programs are compatible to
vour maching, Please read the notes first in each chapter yvou want before download programs.

Touch Panel driver
WP-Q000-CE? provide drivers of PenMount, and ELO touch pansls (USB/RS-232). Please download
the driver(s) to yvour WinPAC and double-click it to install the driver.

Touch Panel driver download

PenMount LISE TOLUCH ADP-10B80T-L1

PenMount Serial TOUCH ADP-10B0T-R

ELO LISE TOLICH ELO LSE touch panel
ELD Serial TOUCH ELO RS-232 touch pansl

How to upgrade OS image of WP-9000-CE7
Thera are two methods to upgrade 05 image of WP-9000-CEZ. The first ane is to run installation
package file on WinPAC and the sacond is to use Eshell.exe to upgrade 05 image through Ethemnet.

Rl o T e T T T T e T g g
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Tips — How to

This chapter provides tips and a guided tour on using and maintaining the WP-9000-CE7.

WP-9000-CE7 Series User Manual, version 1.0.2 Page: 133

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved. < E-mail: service@icpdas.com




A. How to Use the Printer

WP-9000-CE7 have ability to access the printer, the printer can be connected via an Ethernet or a
USB.

Tips & Warnings

A WP-9000-CE7 only supports HP Laser Jet Printers with PCL6 driver. The
following printer support is released by HP:

. HP Laserlet 4000 series/HP LaserJet 4100 series
o HP Laserlet 2100 series/HP LaserJet 2200 series
d HP LaserJet 1200

. HP LaserJet 3200/HP LaserJet 3300

. HP Laserlet 4200 series/HP LaserJet 4300 series
o HP Laserlet 5000 series/HP LaserJet 5100 series
*  HP Laserlet 8000 series

o HP LaserJet 9000 series printers

If you need the latest support of HP PCL6 printer, you can refer to following

link
http://h20000.www2.hp.com/bizsupport/TechSupport/Document.jsp?objec
tID=bpl04568
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A.1. How to Use a Network Printer

Here are step by step instructions on how to use a shared printer.

Step 1: On PC side, check the name of the PC and the shared printer

System Properties

Syztem Restore Automatic Updates || Remate |

Hardware | Advanced |

9’ i ation to identify your computer

Camputer dezcription: ||

General

For example: "Kitchen Computer or "bMary's
Computer'.

/
Full computer name: ervertame.

Wworkgroup:
To use the Metwork, ldentification ‘wizard ta join a

domain and create a local user account, click Metwork,
0.

To rename thiz comp

e ———
Z

—

| = semarrehnare this printer with other users on your nebwork, To
gg enable gharing for thiz printer, click Share thiz printer.

(") Do nat share this printer

/4 Changes wil ta

Share name: |F'lintetNamE:|

Drivers

If thiz printer iz shared with uzers nning different verzions of
Windows, you may want bo install additional drivers, so that the
uzers do not have to find the print driver when they connect to
the shared printer.

Additional Drivers...

[ 0k, ][ Cancel l[ Apply ] Help
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Step 2: On WP-9000-CE7 — Run the Notepad, and then open a WordPad format file

File Edit View Go Favorites |¢|-p|
il 3
I]]ﬂ«gdrESS | YSyster_Diskvools\notepad e

history inotepad Hew CtrlaN
[B]al=Ty] Ctr+
Ctrl+5
~, ;—-—-ﬂxuf""xﬂ-um

Step 3: Set up the printer
1. Printer: PCL Laser
2. Port: Network
3. Net Path: \\ServerName\PrinterName
The “ServerName” is the name or IP of the PC.
The “PrinterName” is the name of share printer of the PC.

4. Paper Size: Select the paper size

| File Edit View Format Tools | = K |Tah|:|m hd |14
Test 111
Print E]
Printer: |F'CL Laser | Print Range Orientation
Port: |Netwu:|rk w @ Al @ Portrart
— () selection () Landscape

Met Path: |F:D1-User2mnna

Margins {inches)

Left: |1.25" Top: |1"

Paper Size: |ﬂ~4

€

[ ] Draft Made
Advanced Colar Right: [r.25"  Battom: [11
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A.2. How to Use a USB printer

Here are step by step instructions on how to use a USB printer via a USB port.

Step 1: Run the Notepad, and then open a WordPad format file

=0 it
(0]al=g] Ctrl+0
Save Ctr+5

Step 2: Set up the printer
1. Printer: Hewlett-Packard Laserlet
2. Port: LPT1

3. Paper Size: Select the paper size

|Fi|E Edit View Format Tools | = E K |Tah|:|rr| e |14 e
Test 111
Print L
Printer: IHEWlEﬁ-P&CkﬂId Lazrh s | Print Range Orientation
Part: [LTe v (@) Al (8) Partrait
Selection Larndscape
MNet Path: | O O H
. Margins (inches)
Paper Size: |ﬂ~4 v
[ orat Mo - Left: Il.ES" Top: |1"
Advanced rart Mode Afln m N
Eell Right: |1,25 Bottom: |1
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B. How to Online Debug the WP-9000-CE7 Program

Here are step by step instructions on how to online debug the WP-9000-CE7 program.

Tips & Warnings

A\

Before starting online debug the WP-9000-CE7 program, make sure that the
WP-9000-CE7 SDK has been installed correctly.

For more information on how to install the WP-9000-CE7 SDK, please refer

to 4.1.2. Installing the WP-9000-CE7 SDK.

Step 1: Copy the following files to the \System_Disk\icpdas\system on the WP-9000-CE7

By default, these files are located on the development computer at C:\Program

Files\Common Files\Microsoft Shared\CoreCon\1.0\Target\wce400\<CPU>.

clientshutdown.exe

CMAccept.exe

ConmanClient2.exe

eDbgTL.dll

TcpConnectionA.dll

Step 2: Run the ConmancClient2.exe and then CMAccept.exe on the WP-9000-CE7

mfc20ipn

pacnet

L)

atlso

)

rnfcB0kor

)

mfc90ita

)

pacsdk

I]]ﬂgldrezs | WSystermn_Diskicpdasisysten

fie

autoinit

mfc90jpn

)

pacsdk_wm

@] (%
mfcB0chs  mfcB0cht
@) (%
mfc80ud  mfc90chs
@] (%
rfc90kar rnfc90u
Iy

eDbgTL

Nt TN NS T

WP-9000-CE7 Series User Manual, version 1.0.2

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved.

|

mfc20den

)

rnfc0cht

)

L)

mfc20enu

)

mifc90dew

|

mfc20esp

)

rnfcS0eru
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Step 3: On the Tools menu, click the Options

File Edit View Project Build Debug Test Window Help
AR AERA=A" B- IR TR v‘ 5% Attach to Process.. Ctrl+Alt+P
: AM335x_WINCE7_SDKAF v | 85 [ | 42 | ®a| Device Security Manager...

Connect to Device...

External Tools...

Import and Export Settings...

Step 4: In the left pane, expand Device Tools node and select Devices

Step 5: In the Show devices for platform:, select AM335x_WINCE7_SDK and then click
Properties

Options

Environment
Projects and Solutions
Source Control
Text Editor
Database Tools
Debugging
Device Tools

General

Devices

Form Factors
HTML Designer
Office Tools
Test Tools
Text Templating
Windows Forms Designer
Workflow Designer

AMI35X_ WINCE/ _>uin mivivi v s wsevice

Default device:

AM335x_WINCE7_SDK ARMV7 Device

WP-9000-CE7 Series User Manual, version 1.0.2 Page: 139

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved. < E-mail: service@icpdas.com




Step 6: Click the Configure...

AM335x_WINCE7_SDK ARMV7 Device Properties

B S e e

Default output location on device:

Transport:

|TCP Connect Transport

Bootstrapper:

|ActiveSync Startup Provider

Detect when device is disconnected

Configure..

QK ‘ ‘ Cancel

Step 7: Select the Use specific IP address:, and then type the IP address of WP-9000-CE7

Configure TCP/IP Transport

%)

Use fixed port number: 5655

Device IP address

QK

Cancel
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Step 8: Click the OK, and then click OK to end the dialog

AM335x_WINCE7_SDK ARMV7 Device Properties ")
—

. —

Default output location on device:

Transport: i
[TCP Connect Transport e l l Configure... l
Bootstrappen:

[ActiveSync Startup Provider '] ‘ Configure.. ‘

[#] Detect when device is disconnected

=

> Environment Show devices for platform:
» Projects and Solutions

» Source Control

» Text Editor

» Database Tools

» Debugging

a Device Tools
General Rename...

| AM335x_WINCE7_SDK -

Devices:

AM335x_ WINCE7_SDK ARMV7 Device

Save As...

| Devices|

Form Factors
» HTML Designer .
» Office Tools Properties...
» Test Tools
» Text Templating
> Windows Forms Designer
» Workflow Designer

Delete

Default device:

AM335x_WINCE7_SDK ARMV7 Device j

WP-9000-CE7 Series User Manual, version 1.0.2 Page: 141

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved. < E-mail: service@icpdas.com




Step 9: On the Tools menu, click the Connect to Device...

File Edit View Project Build Debug Test Window Help
H Attach to Process... Ctrl+Alt+P

Connect to Device...

Device Emulator Manager...

Connect to Database...

Connect to Server...

Code Snippets Manager... Ctrl+K, Ctrl+B

Step 10: Wait for the connection to be established

Connecting...

2 :

To 'AM335x WINCE7_SDK ARMV7 Device'
Connection succeeded.

Tips & Warnings

A If the connection fails, as shown below, please repeat the step 2 to step 9 to
try it again.

To 'AM335x WINCE7_SDK ARMV7 Device'

Connection failed. ActiveSync bootstrap initialization
failed.
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C. How to Automatically Synchronize WP-9000-CE7 Clock with an
Internet Time Server

The clock on the WP-9000-CE7 can be synchronized with an internet time server. This means that
the clock is updated to match the clock on the time server, which can help ensure that the time on
the WP-9000-CE7 is accurate. Here are step by step instructions on how to synchronize the clock
on the WP-9000-CE7 with an Internet time server.

Step 1: Run the PAC Utility

N4

-

PAC_Utility

Step 2: On the General tab, press Configure button

PAC Utility [1.2.1.4]

File Help

General | General2 I Display IIF' Config I Metwark I Device Information I.-'l'-.ub] Execution I Rotary Exg 4| ¥

Welcome o use PAC Utility
This tool will help you easy o
Lse PAC CE series,

PAC Utility

Task Bar setting:
[ suto Hide
[ always On Top

HIVE Reqistry:
) AUt Save Tao Flash (Default)

e e () Maunal Save To Flash

Backplane Battery [7] Enable sutarun in plugging USE Disk
Batteryl : OK Battery2 : OK [] Enable sutarun in plugging Micro SD
RTC Battery

Configure the synchronization with a time selwer Backlight Setting
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Step 3: Select the domain name from the Server drop-down list, and then enter a value
in the Autoupdate Frequency field

Step 4: Check the Automatically synchronize with an internet time server check box

Stepl: Server: |1J:|ck.usn|:|.naw,r.mil ﬂ
Step2: Autoupdate Frequency: (20160 | minute
Step3:

[v] Automatically synchronize with an internet time server

Lipdats Mow

Step 4:Go to "File" -->"Save and Reboot" 1o enable
driver

ALt update running

Step 5: On the File menu, click Save and Reboot

PAC Utility [1.2.1.4]
F=8 Help

Save and Reboot
Reboot

Restore Utility Default Settings

Step 6: The WP-9000-CE7 will automatically synchronize with an internet time server
regularly

Stepl: Server: |b:uck.usnn:u.naw. mil ﬂ

Step 7: Click the Update Now button to .
Step2: Autoupdate F . |20180 te
synchronize WP-9000-CE7 clock s AUTBUPEETS FrEUEncY il

immediately S
w synchronize with an internet time serei._|
Lipdate Mo |
WE!" --="Saye and Reboot” o enablz
driver

Auto update running
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D. How to Control the User Account Control in WP-9000-CE7

User Account Control is a security feature that helps prevent unauthorized system changes to the
WP-9000-CE7.
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D.1. How to Create a User Account

Here are step by step instructions on how to add a user account.

Step 1: Run the PAC Utility

X

PAC_Utility

Step 2: On the Login tab of the Network tab, click Login tab, type the User Name and
Password, and then click Add button

PAC Utility [1.2.2.0] | _|
IGeneraI I General? I Display IIF' Config | Metwork |Device Infor mation I.&uh: Execution IRDtary E}{d 1 I 4
IAccess| Login |
User Mame Password
ficroes N |  4od || Delet
User name I Password I
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Step 3: The user has been added to the allowed under the remote login and included in
the following list

PAC Utility [1.2.2.0] !
File Help

[General IGeneraI2 IDispIa\; IIF' Config | Network |Device Information IAuh: Exerution IRDtary Ex4 i I »

I Access | Login |

Lizer Marmne Password

icP Das | [~ | add || Delete

User name | Password

Step 4: On the File menu, click Save and Reboot for changes to take effect
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D.2. How to Telnet to Remote Login the WinPAC from PC

Here are step by step instructions on how to use telnet to remote login the WinPAC from PC.

Step 1: On the PC, open a MS-DOS command prompt

- L L .
‘L‘/ Windows Catalog g‘
S
% Windows Update ‘;
m Programs 4 "/f
g ‘ Documents » é’ - Type the r ent, or
% O setios , 1 : Internet rex it For you.
; | Open: |ENE v
& @) Hep ft <
% 3
_§ H— 5\
SN 5
E3 (0] shutDown... 1 [ OK ] [ Cancel ] [ Browse... J

21start | o clwmoowsisyste..

Step 2: At the command prompt, type “telnet (IP address)”

w CAWINDO WS evstem32wmd .exe

C=“Documents and Settingz“MWindows>telnet 168.1.8.31
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Step 3: The connection has been set up, and then type the name and password

Telnet 10.1.0.31

llelcome to the Windows CE Telnet Service on Compact

login: ICPDAS
Password:

Step 4: The remote login has been completed

Melcome to the Windows CE Telnet Serwvice on Compact

login: ICPDAS
Password:

CMD » 7.088
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D.3. How to Remove a User Account from the Login List

Here are step by step instructions on how to remote the user from the login list.

Step 1: Click a user from the list which you want to remove, and the user will display in
the field, and then press Delete to delete the user from the login list

PAC Utility [1.2.2.0] !

File Help

IGeneraI General2 IDispIay IIP Config | Metwork |Device Infar mation IAum Execution IRotary Exsl 1 I 4

[ Access | LOgin |

User Mame Passwiord
ice Das | [ || add | Dekte
User name | Password

Step 2: On the File menu, click Save and Reboot for changes to take effect
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E. How to change the battery

RTC is retained by a Li-ion battery, which can supply
continuous power for 10 years. The battery design has the
added function of preventing data from being lost while
replacing the battery. The following figures show the
location of the battery installed in the Win PAC CPU board.

Checking the current battery power

1. Run the PAC utility and check the Battery 1 fields that display the current status. Refer to
Section 3.1 PAC utility “General” for more details. If the power level is low that the battery

should be replaced.

2. When programming this, call the pac_GetBatteryLevel() APl function in the PACSDK.dII to
check whether the battery power is low. When the power of the battery is low, it’s
recommended that the battery is replaced immediately, otherwise the RTC time will be reset.

Replacing the battery

Power off the WIinPAC device.

Remove the CPU board.

Remove the battery that is running low on power from the battery holder in CPU board.
Insert a new battery.

Set the RTC time.

gk~ wbde

Ordering information

Battery type: BR1632 (Part number is 2LB010 for ICP DAS)

For more detailed information, contact your local sales office or distributor.
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F. How to Using the Practical Functions of the 3G/4G I/O Module

F.1. How to Auto Dial 3G/4G GPRS network and redial when the network
disconnected

The AutoDialer allows user to automatically dial GRPS network after boot.
When the GRPS network disconnect the AutoDialer will automatically re-dial Internet access.

Tips & Warnings

A Before installing the SIM card, please cancel the PIN lock function of SIM
card; otherwise you will not be able to dial the Internet

The demos can be found on the CD that was provided with the package or by downloading the
latest version from ICP DAS web site.
CD:\WinPAC_AM335x\wp-5231\demo\3g_modem\autodialer\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/3g modem/autodialer/

The description of the demo can be found by downloading the latest version from ICP DAS web
site.

http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/document/fag/development/
W5-13_How_to_use_Auto_dial_GPRS_network_and_redial_when_the_network_disconnected_en
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F.2. How to Use the SMS Function and Get the GPS Data

The 3G/4G modem allows the user to use the SMS function and get the GPS data.

The APl manual can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/demo/3g modem/3g modem sms dem

o/gsm lib manual v1.0.1.pdf

The demos can be found on the CD that was provided with the package or by downloading the
latest version from ICP DAS web site.

CD:\WinPAC_AM335x\Wp-5231\demo\3g_modem \3G_modem_SMS_Demo)\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/3g modem/3g modem sms dem

o
The description of the demo can be found by downloading the latest version from ICP DAS web
site.

http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/document/fag/development/
W5-14_How_to_use_the_SMS_function_and_get_the_GPS_data_en
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/3g_modem/3g_modem_sms_demo/gsm_lib_manual_v1.0.1.pdf
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/3g_modem/3g_modem_sms_demo/gsm_lib_manual_v1.0.1.pdf
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/3g_modem/3g_modem_sms_demo
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/3g_modem/3g_modem_sms_demo
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/document/faq/development/

F.3. How to Synchronize the System Time by GPS Data

The demos can be found on the CD that was provided with the package or by downloading the
latest version from ICP DAS web site.
CD:\WinPAC_AM335x\Wp-5231\demo\3g_modem\gpstimesynchronization\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/3g modem/gpstimesynchronizati

on

The description of the demo can be found by downloading the latest version from ICP DAS web
site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/document/faqg/development/

W5-15_How_to_Synchronize_the_system_time_by_GPS_data_en
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/3g_modem/gpstimesynchronization
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/document/faq/development/

G. Application of RS-485 Network

The RS-485 length can be up to 4000 ft or 1.2 km over a single set of twisted—pair cables, if the
RS-485 network is over 4000 ft or 1.2Km, the RS-485 repeater must be added to extend the
RS-485 network.
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G.1. Basic RS-485 Network

The basic component of the RS-485 network consist of a Master Controller (or using a PC as a host

controller), and some RS-485 devices.

(I-7520 Series)
RS-232/ RS-485
Converter
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G.2. Daisy Chain RS-485 Network

All RS-485 devices are wired directly to the main network, If the network is up to 1.2 km, it will

need a repeater (7510 series) to extend the network length.

=

(1-7510 Series) (I-7510 Series)
(1-7520 Series) RS-485 Repeater RS-485 Repeater
RS-232/ RS-485
Converter
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G.3. Star Type RS-485 Network

There are branches along the main network. In this case, it is better to have a repeater to isolate or

filter the noise that is made by devices.

(I-7520 Series)
RS-232/ RS-485

Converter
(I-7510 Series) (1-7510 Series) (I-7510 Series)
RS-485 Repeater RS-485 Repeater RS-485 Repeater
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There is a better choice to use 7513 as a RS-485 hub on star type network.

(I-7520 Series)
RS-232/ RS-485
Converter

(I-7513 Series)
RS-485 Hub
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G.4. Random RS-485 Network

There are branches along the main wire. In this case, it is better to have a repeater to isolate or

filter the noise that is made by devices.

(1-7510 Series)
(I-7520 Series) RS-485 Repeater
RS-232/ RS-485
Converter

(I-7510 Series)
RS-485 Repeater

k| | A o
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G.5. Master/Slaves Settings

The RS-485 network based on master-slave architecture consists of a single master device and one

or more slave devices.

The WiInPAC provides two RS-485 communication interfaces based on the master-slave system
architecture, COM2 have a pull-high/pull-low resistor, user can set it to master or slave for

implementing an RS-485 multi-drop network. COM3 is always set in Master mode.

The termination resistor, with the same value as the line impedance (120 ohm), eliminates the
majority of the signal reflection. The WinPAC provides on-board 1200hm termination resistor for
each RS-485 port.

The pull-high/pull-low resistor and its termination resistor of COM?2 are located on the 9K-PB0O1

power board, as shown below.

The termination resistor of COM3 is located on the 9K-SB01 board, as shown below.

[ 9K-PBOL
[ 9K - PBO1 SBO'].
A IR
— ]
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G.5.1. WIinPAC acts as a Master (default)

When one of WInPAC is set to master, then all the other devices on the same network must be
slave mode. If the network is up to 1.2 KM, it will need a repeater (7510 series) to extend the
network length.

(I-7510 Series) (I-7510 Series)
RS-485 Repeater RS-485 Repeater
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When WinPAC as a master using COM2 communication 9K-PBO1
interface, the SW1 DIP switch located on the power boardis oo

used to set the COM2 as master or salve.

The 1" and 2™ dip switches
are used to assign the WinPAC

=
A

]

S WEplEE -
e P EEE "\ 10

as a master or slave.

Master Mode

Switch
Mode

Master (Default) ON

|F‘H'F‘FH}JI
I
—

Slave OFF OFF

(!
oN
1
12
R

The 3" dip switch is reserved. The default setting is OFF.
The 4™ dip switch is used to enable or disable the termination resistor. The default setting is OFF.

COM3 is always on Master mode
There is a jumper-selectable 120-ohm termination resistor for COM3, as shown below.

( )
Disable the termination resistor 9K-SB01
(Default)

Enable the termination resistor

120 Ohm

\. J
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G.5.2. WIinPAC acts as a Slave

For most of application, when using one 7520 series as RS$-232/485 converter, its pull-high/pull-low
resistors are set to enabled. Then the WinPAC-8000 and all the other devices on this network must
be slave mode (the pull-high/pull-low resistors must be disabled).

If there are repeaters on the RS-485 network, there will be pull-high/pull-low resistors on both
sides of the repeaters (I-7510)

(I-7510 Series) (I-7510 Series)
(1-7520 Series) RS-485 Repeater RS-485 Repeater

RS-232/ RS-485

Converter

Slave Slave

When WinPAC as a master using COM2 communication 9K-PBO1
interface, the SW1 DIP switch located on the power boardis oo

used to set the COM2 as master or salve.

The 1% and 2" dip switches
are used to assign the WinPAC

as a master or slave.

Slave Mode
w 1
Mode
Master (Default) OFF OFF P
m— ||
Slave ON ON ]
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H .Revision History

This chapter provides revision history information to this document.

The table below shows the revision history.

Revision Date Description
1.0.0 January 2016 Initial issue
1.0.1 April 2018 Added the information about the 3G/4G applications in Appendix E.
1.0.2 September 2020 | Added the appendix about RS-485 network in Appendix F.
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